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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Software Version Conventions Used in This Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11, 4.2 and IntranetWare.

Notes

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Trademarks

Adobe, Acrobat, Acrobat Reader, PostScript, and Reader are either registered trademarks or trade-
marks of Adobe Systems Incorporated in the United States and/or other countries. 

Apple, AppleTalk, Bonjour, Macintosh, Mac OS and Safari are registered trademarks of Apple Inc., reg-
istered in the U.S. and other countries.

Citrix® and MetaFrame® are registered trademarks of Citrix Systems, Inc.

Firefox® is a registered trademark of Mozilla Foundation.

Microsoft®, Windows®, Windows NT®, Windows Server®, and Windows VistaTM. are either registered
trademarks of Microsoft Corporation in the United States and/or other countries.

Monotype is a registered trademark of Monotype Imaging, Inc.

Novell, NetWare, NDS and NDPS are registered trademarks of Novell, Inc.

PCL® is a registered trademark of Hewlett-Packard Company.

PictBridge is a trademark.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

UPnP is a trademark of the UPnP Implementers Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product names of Windows 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

• The product names of Windows XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Media Center Edition
Microsoft® Windows® XP Tablet PC Edition

• The product names of Windows Vista are as follows:
Microsoft® Windows Vista™ Ultimate
Microsoft® Windows Vista™ Enterprise
Microsoft® Windows Vista™ Business
Microsoft® Windows Vista™ Home Premium
Microsoft® Windows Vista™ Home Basic

• The product names of Windows Server 2003 are as follows:
Microsoft® Windows Server® 2003 Standard Edition
Microsoft® Windows Server® 2003 Enterprise Edition
Microsoft® Windows Server® 2003 Web Edition
Microsoft® Windows Server® 2003 Datacenter Edition

• The product names of Windows NT 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0
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Manuals for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

Important

❒ Media differ according to manual.

❒ The printed and electronic versions of a manual have the same contents.

❒ Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

❒ Depending on which country you are in, there may also be html manuals. To
view these manuals, a Web browser must be installed.

❖ About This Machine
Be sure to read the Safety Information in this manual before using the ma-
chine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.

❖ Troubleshooting
Provides a guide to solving common problems, and explains how to replace
paper, print cartridge, and other consumables.

❖ Copy Reference
Explains Copier functions and operations. Also refer to this manual for expla-
nations on how to place originals.

❖ Facsimile Reference
Explains Facsimile functions and operations.

❖ Printer Reference
Explains Printer functions and operations.

❖ Scanner Reference
Explains Scanner functions and operations.

❖ Network Guide
Explains how to configure and operate the machine in a network environ-
ment, and use the software provided.

❖ General Settings Guide
Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.
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❖ Security Reference
This manual is for administrators of the machine. It explains security func-
tions that you can use to prevent unauthorized use of the machine, data tam-
pering, or information leakage. For enhanced security, we recommend that
you first make the following settings:

• Install the Device Certificate.

• Enable SSL (Secure Sockets Layer) Encryption.

• Change the user name and password of the administrator using Web Im-
age Monitor.

For details, see “Setting Up the Machine”, Security Reference.
Be sure to read this manual when setting the enhanced security functions, or
user and administrator authentication.

❖ PostScript 3 Supplement
Explains how to set up and use PostScript 3.

❖ UNIX Supplement
For “UNIX Supplement”, please visit our Web site or consult an authorized
dealer.
This manual includes descriptions of functions and settings that might not be
available on this machine.

❖ Other manuals

• Manuals for DeskTopBinder Lite

• DeskTopBinder Lite Setup Guide

• DeskTopBinder Introduction Guide

• Auto Document Link Guide

Note

❒ Manuals provided are specific to machine types.

❒ The following software products are referred to using general names:

*1 Optional

Product name General name

DeskTopBinder Lite and DeskTopBinder Pro-

fessional *1 

DeskTopBinder

ScanRouter EX Professional *1  and ScanRouter 

EX Enterprise *1 

the ScanRouter delivery software
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates important safety notes.

Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the “Safety Information” section of About This Ma-
chine.

Indicates important safety notes.

Ignoring these notes could result in moderate or minor injury, or damage to the
machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.

[ ]

Indicates the names of keys that appear on the machine’s display panel.

{ }

Indicates the names of keys on the machine’s control panel.

About IP Address

In this manual, “IP address” covers both IPv4 and IPv6 environments. Read the
instructions that are relevant to the environment you are using.
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1. Using a Printer Server

Preparing Printer Server

This section explains how to configure the machine as a Windows network
printer. The machine is configured to enabling network clients to use it. When
the network printer is connected via SmartDeviceMonitor for Client, you can set
the printing notification function to notify clients of the results of their print jobs.

Important

❒ Under Windows 2000, Windows XP Professional, Windows Vista, or Win-
dows Server 2003, to change printer properties in the [Printer] folder, you need
Printer Management access authentication. Log on to the file server as an Ad-
ministrator or member of the PowerUsers group.

A Open the [Printers] window from the [Start] menu.

The [Printers] window appears.

Under Windows XP or Windows Server 2003, [Printer and Fax] window ap-
pears.

B Right-click the icon of the the machine you want to use, and then click
[Properties]. The printer properties appear.

C On the [Sharing] tab, click [Shared As:].

Under Windows XP/Vista or Windows Server 2003, select [Share this printer]
check box.

D To share the machine with users using a different version of Windows,
click [Additional Drivers...].

If you have installed an alternative driver by selecting [Share As:] during the
printer driver installation, this step can be ignored.

E Click [OK], and then close the printer properties.
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Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the machine to use the printing notifi-
cation function of SmartDeviceMonitor for Client.

Setting the Print Server

Important

❒ Under Windows 2000, Windows XP Professional, Windows Vista, or Win-
dows Server 2003, to change printer properties in the [Printer] folder, you need
Printer Management access authentication. Log on to the file server as an Ad-
ministrator or member of the PowerUsers group.

A On the [Start] menu, point to [Programs], [DeskTopBinder], [SmartDeviceMonitor
for Client], and then click [Print Server Setting].

The print server setting dialog box appears.

B Select the [Notify client PCs of printout/data-transmission] check box, and then
click [OK].

After print server setting is made, a dialog box appears. Confirm the dialog
box content, and click [OK].

Click [Cancel] to interrupt the procedure.

A dialog box appears for client setting. 

C Click [OK].

The print server setting is completed. Each client must be set to receive print
notification.

Note

❒ Current printing jobs restart from the beginning after the spooler pauses
briefly.

❒ When the expansion function is not used, the function is automatically set
as available.

❒ If you log on using an account that does not have Administrator privileges,
the client may not be notified.

❒ For details, see “Using the SmartDeviceMonitor for Client Port”, Printer
Reference.
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Setting a Client

A On the [Start] menu, point to [Program], [DeskTopBinder], [SmartDeviceMonitor
for Client], and then click [Extended Features Settings].

A dialog box for setting the expansion function appears.

B Select the [Notify of printout/data-transmission when using print server] check box.

C Click [OK].

 The client setting is completed.

Note

❒ Set the printing notification function on the printer driver as well as on
SmartDeviceMonitor for Client.
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Using NetWare

This section describes the setting procedure for network printers in the NetWare
environment. In the NetWare environment, you can connect the machine as a
“print server” or “remote printer”.

Important

❒ IPv6 cannot be used on this function.

❖ Setting procedure

• When using the machine as a print server

A Installing SmartDeviceMonitor for Admin

B Setting the network interface board.

C Turning the machine off and then back on.

•  When using the machine as a remote printer

A Installing SmartDeviceMonitor for Admin.

B Setting the network interface board. 

C Setting NetWare.

D Starting the print server.
This procedure assumes an environment is already prepared for normal Net-
Ware running the printing service setting.
The procedure is explained with the following example settings:

• File server’s name …CAREE

• Print server’s name …PSERV

• Printer’s name …R-PRN

• Queue name …R-QUEUE

❖ Using SmartDeviceMonitor for Admin
To use the machine in a NetWare environment, use SmartDeviceMonitor for
Admin to set the NetWare printing environment. 
The NetWare Client provided by Novell is required to set the printing envi-
ronment using SmartDeviceMonitor for Admin under the following environ-
ments:

• NDS or Bindery mode in Windows 2000/XP

❖ Printers listed by SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin lists printers connected to the network. If
you cannot identify the machine you want to configure, print configuration
page, and then check the machine name.

Reference

p.32 “Installing SmartDeviceMonitor for Admin”



Using NetWare

7

1

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the machine as a print server using Net-
Ware 3.x.

A Start Web Image Monitor.

B Click [Login].

A dialog box for entering the login user name and password appears.

C Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

D Click [Configuration] in the menu area, and then click [NetWare] on the [Net-
work] area.

• Print Server Name: Enter the NetWare print server name. To use the inter-
face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

• File Server Name: When a file server name is entered here, only the speci-
fied file server is searched for. This item is mandatory. Use up to 47 char-
acters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 characters.

• Operation Mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

• Remote Printer No.: This item is effective when the interface board is spec-
ified as a remote printer. Enter the same number as the number of the
printer to be created on the print server (0 to 254 characters).

• Job Timeout: When the interface board is used as a NetWare remote print-
er, the printer cannot detect when a print job ends. Therefore, the printer
terminates printing when a certain period of time has elapsed since it last
received print data (i.e., when it has not received print data for a certain pe-
riod of time). Specify here this period of time (3 to 255 seconds). The initial
value is 15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.

• Print Server Protocol: Select the protocol for NetWare from the drop-down
menu.

• NCP Delivery Protocol: Select the protocol for NCP delivery.
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E Confirm the settings, and then click [OK].

Configuration is now complete. Wait several before restarting Web Image
Monitor.

F Click [Logout].

Note

❒ To check the configuration is correct, enter the following from the com-
mand prompt:

F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see “Print I/F Settings List”, General
Settings Guide.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

❒ For details about Web Image Monitor, see “Using Web Image Monitor”.

Reference

p.19 “Using Web Image Monitor”

Setting Up as a Print Server (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to connect the machine as a print server using Net-
Ware 4.x, NetWare 5 / 5.1, or NetWare 6 / 6.5.

Important

❒ When using the printer as a print server in NetWare 4.x, NetWare 5 / 5.1, or
NetWare 6 / 6.5, set it to the NDS mode.

❒ When using NetWare 5 / 5.1 or NetWare 6 / 6.5, set the printer as a print serv-
er.

A Start Web Image Monitor.

B Click [Login].

A dialog box for entering the login user name and password appears.

C Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

D Click [Configuration] in the menu area, and then click [NetWare] on the [Net-
work] area.
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E Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].

G Quit Web Image Monitor.

Note

❒ To check the configuration is correct, enter the following from the com-
mand prompt:

F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see “List/Test Print”, General Set-
tings Guide.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Nework] dialog box of Windows to
change the frame type of the computer.

❒ For details about Web Image Monitor, see “Using Web Image Monitor”.

❒  For details about login user names and passwords, see Security Reference,
which is the administrator’s manual.

Reference

p.19 “Using Web Image Monitor”
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Using Pure IP in the NetWare 5 / 5.1 or 6 / 6.5 Environment

Follow the procedure below to connect the machine as a print server in a pure IP
environment of NetWare 5 / 5.1 or NetWare 6 / 6.5.

Important

❒ When creating a queued print server in a pure IP environment of NetWare 5
/ 5.1 or NetWare 6 / 6.5, create a print queue on the file server using NetWare
Administrator.

❒ This printer is not available as a remote printer for use in a pure IP environ-
ment.

❒ To use the printer in a pure IP environment, set it to IPv4.

Setting up using NWadmin

A From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

B Select the object in which the print queue is located in the directory tree,
and then click [Create] on the [Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Select the object in which the printer is located, and then click [Create] on
the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name.

K Select the [Define additional properties] check box, and then click [Create].

L Click [Assignments], and then click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you created, and then click [OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].
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P Check the settings, and then click [OK].

Q Select a context specified using NIB Setup Tool, and then click [Create] on
the [Object] menu.

R In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Server (Non NDPS)].

S In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

T Select the [Define additional properties] check box, and then click [Create].

U Click [Assignments], and then click [Add] in the [Assignments] area.

V In the [Available objects] box, click the queue you created, and then click [OK].

W Check the settings, and then click [OK].

Setting up using Web Image Monitor

A Start Web Image Monitor

B Click [Login].

A dialog box for entering the [Login User Name] and [Login Password] appears.

C Enter the user login user name and password, and then click [Login].

For details about the login name and password, consult your network admin-
istrator.

D Click [Configuration] in the menu area, and then click [NetWare] on the [Net-
work] area.

E Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].

G Quit Web Image Monitor.
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Note

❒ If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see “List/Test Print”, General Set-
tings Guide.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

❒ For details about Web Image Monitor, see “Using Web Image Monitor”.

❒ For details about login user names and passwords, see Security Reference,
which is the administrator’s manual.

Reference

p.19 “Using Web Image Monitor”

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the machine as a remote printer under Net-
Ware 3.x.

Setting up using PCONSOLE

A Enter “PCONSOLE” from the command prompt.

F:> PCONSOLE

B Create a print queue.

When using the existing print queue, go to the procedure for creating a print-
er.

C From the [Available Options] menu, select [Print Queue Information], and then
press the {Enter} key.

D Press {Insert} key, and then enter a print queue name.

E Press {Esc} key to return to the [Available Options] menu.

F Set up the network connection to a printer.

G On the [Available Options] menu, click [Print Server Information], and then press
the {Enter} key.

H To create a new print server, press the {Insert} key, and then enter a print
server name.

For a currently defined print server, select a print server in the [Print Server]
list.

Use the same printer name specified using SmartDeviceMonitor for Admin.
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I From the [Print Server Information] menu, select [Print Server Configuration].

J From the [Print Server Configuration] menu, select [Printer Configuration].

K Select the printer indicated as [Not Installed].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

L To change the printer name, enter a new name.

A name “printer x” is assigned to the printer. The “x” stands for the number
of the selected printer.

M As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automatical-
ly configured.

N Press the {Esc} key, and then click [Yes] on the confirmation message.

O Press the {Esc} key to return to [Print Server Configuration Menu].

P Assign print queues to the created printer.

Q From [Print Server Configuration Menu], select [Queues Serviced By Printer].

R Select the printer created.

S Press the {Insert} key to select a queue serviced by the printer. 

You can select several queues.

T Follow the instructions on the screen to make other necessary settings.

Following these steps, check that the queues are assigned.

U Press the {Esc} key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

V Start the print server by entering the following from the console of the Net-
Ware server.

 If the print server is in operation, quit and restart it.

❖ To quit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name

Note

❒ If the printer works as configured, the message “Waiting for job” appears.
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Setting up using Web Image Monitor

A Start Web Image Monitor

B Click [Login].

A dialog box for entering the [Login User Name] and [Login Password] appears.

C Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

D Click [Configuration] in the menu area, and then click [NetWare] on the [Net-
work] area.

E Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].

G Quit Web Image Monitor.

Note

❒ If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see “List/Test Print”, General Set-
tings Guide.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

❒ For details about Web Image Monitor, see “Using Web Image Monitor”.

❒ For details about login user names and passwords, see Security Reference,
which is the administrator’s manual.

Reference

p.19 “Using Web Image Monitor”
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Setting Up as a Remote Printer (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to use the printer as a remote printer under Net-
Ware 4.x, 5 / 5.1 and 6 / 6.5.

Important

❒ To use the printer as a remote printer under NetWare 4.x, 5 / 5.1, 6 / 6.5, set
it to NDS mode.

❒ Do not use the printer as a remote printer when Pure IP is used. 

Setting up using NWadmin

A From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

B Set up the network connection to a print queue. Select the object in which
the print queue is located in the directory tree, and then click [Create] on the
[Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Set up the network connection to a printer. Select the object in which the
printer is located, and then click [Create] on the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name

K Select the [Define additional properties] check box, and then click [Create].

L Assign print queues to the created printer. Click [Assignments], and then
click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you created, and then click [OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].
Check the settings, and then click [OK].
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P Set up the network connection to a print server. Select a context specified
using NIB Setup Tool, and then click [Create] on the [Object] menu.

Q In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

R In the [Print Server Name:] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

S Select the [Define additional properties] check box, and then click [Create].

T Assign the printer to the created print server. Click [Assignments], and then
click [Add] in the [Assignments] area.

U In the [Available objects] box, click the queue you created, and then click [OK].

V In the [Printers] area, click the printer you assigned, and then click [Printer
Number] 

W Enter the printer number, and then click [OK]. Check the settings, and then
click [OK].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

X Start the print server by entering the following from the console of the Net-
Ware server.

If the print server is in operation, quit and restart it.

❖ To exit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name

Y Enter the printer server name as the context name, and then press the {En-
ter} key.

Z Select the printer name on the context menu, and then press the {Enter} key.
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Setting up using Web Image Monitor

A Start Web Image Monitor

B Click [Login].

A dialog box for entering the [Login User Name] and [Login Password] appears.

C Enter the user login name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

D Click [Configuration] in the menu area, and then click [NetWare] on the [Net-
work] area.

E Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].

G Quit Web Image Monitor.

Note

❒ If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see “List/Test Print”, General Set-
tings Guide.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

❒ For details about Web Image Monitor, see “Using Web Image Monitor”.

❒ For details about login user names and passwords, see Security Reference,
which is the administrator’s manual.

Reference

p.19 “Using Web Image Monitor”
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2. Monitoring and Configuring
the Printer

Using Web Image Monitor

Using Web Image Monitor, you can check the machine status and change set-
tings.

❖ Available operations
The following operations can be remotely performed using Web Image Mon-
itor from a client computer.

• Displaying machine status or settings

• Checking the print job status or history

• Interrupting currently printing jobs

• Resetting the printer

• Managing the Address Book 

• Making machine settings

• Making network protocol settings

• Making security settings

❖ Configuring the machine
To perform the operations from Web Image Monitor, TCP/IP is required. Af-
ter the machine is configured to use TCP/IP, operations from Web Image
Monitor become available.

❖ Recommended Web browser

• Windows:
Internet Explorer 5.5 SP2 or higher
Firefox 1.0 or higher

• Mac OS:
Safari 1.0, 1.2, 2.0(412.2) or higher
Firefox 1.0 or higher

Note

❒ Safari 2.0(412.2) cannot be used on Mac OS X 10.4.1.

❒ Display and operation problems can occur if you do not enable JavaScript and
cookies, or if you are using a non-recommended Web Browser.

❒ If you are using a proxy server, change the Web browser settings. Contact
your network administrator for information about the settings.

❒ The previous page may not appear even after the back button of a Web
browser is clicked. If this happens, click the refresh button of a Web browser.

❒ Updating the machine information is not automatically performed. Click [Re-
fresh] in the display area to update the machine information.

❒ We recommend using Web Image Monitor in the same network. 
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❒ You cannot access to the machine from outside the firewall.

❒ When using the machine under DHCP, the IP address may be automatically
changed by the DHCP server settings. Enable DDNS setting on the machine,
and then connect using the machine's host name. Alternatively, set a static IP
address to the DHCP server.

❒ If the HTTP port is disabled, connection to the machine using the machine's
URL cannot be established. SSL setting must be enabled on this machine. For
details, consult your network administrator.

❒ When using the SSL encryption protocol, enter “https://(machine's IP ad-
dress or host name)/”. Internet Explorer must be installed on your computer.
Use the most recent available version. We recommend Internet Explorer 6.0
or later.

❒ Internet Explorer must be installed on your computer. Use the most recent
available version. We recommend Internet Explorer 6.0 or later.

❒ When you are using Firefox, fonts and colors may be different, or tables may
be out of shape.

❒ When using a host name under Windows Server 2003 with IPv6 protocol, per-
form host name resolution using an external DNS server. The host file cannot
be used.

❒ To use JAWS 7.0 under Web Image Monitor, you must be running Windows
OS and Microsoft Internet Explorer 5.5 SP2, or a later version.

Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

Important

❒ When entering an IPv4 address, do not begin segments with zeros. For exam-
ple: If the address is “192.168.001.010”, you must enter it as “192.168.1.10”.

A Start your Web browser.

B Enter “http: //(machine's IP address or host name)/” in the address bar of a
Web browser.

Top Page of Web Image Monitor appears.

If the machine's host name has been registered on the DNS or WINS server,
you can enter it.

When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentication is issued , enter “https://(machine's IP ad-
dress or host name)/”.
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Every Web Image Monitor page is divided into the following areas:

1. Menu area

If you select menu, it's content will be
shown on the work area, or the sub ar-
ea.

2. Tab area

Details about each menu appears.

3. Header area

The dialog box for switching to the
user mode and administrator mode
appears, and each mode's menu will
be displayed. 

The link to help and dialog box for
keyword search appears.

4. Help

Use Help to view or download Help
file contents.

5. Display area

Displays the contents of the item se-
lected in the menu area.

Machine information in the display
area is not automatically updated.
Click [Refresh] at the upper right in the
display area to update the machine in-
formation. Click the Web browser's
[Refresh] button to refresh the entire
browser screen.

Note

❒ When using a host name under Windows Server 2003 or Windows Vista
with IPv6 protocol, perform host name resolution using an exrernal DNS
server. The host file cannot be used.

BEB005S
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When User Authentication Is Set

Login (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.

A Click [Login].

B Enter a login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

Note

❒ For user code authentication, enter a user code in [Login User Name], and
then click [Login].

❒ The procedure may differ depending on the Web browser used.

Log Off (using Web Image Monitor)

Click [Logout] to log off.

Note

❒ When you log on and made the setting, always click [Logout].
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About Menu and Mode

There are two modes available with Web Image Monitor: user mode and admin-
istrator mode.

Displayed Items may differ depending on the machine type.

❖ About User Mode
In the user mode, machine status, settings, and print job status can be viewed,
but the machine settings cannot be changed.

1. Home

The [Status], [Device Info], [Counter],
and [Inquiry] tab are displayed. Details
of the tab menu are displayed on the
work area.

2. Printer: Print Jobs

Allows you to display list of Sample
Print, Locked Print, Hold Print, and
Stored Print jobs.

3. Job

Display all print files.

4. Configuration

Display current machine and network
settings.

BEB006S
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❖ Administrator Mode
In the administrator mode, you can configure various machine settings.

1. Home

The [Status], [Device Info], [Counter],
and [Inquiry] tab are displayed. Details
of the tab menu are displayed on the
work area.

2. Printer: Print Jobs

Allows you to display list of Locked
Print, Sample Print, Hold Print, and
Stored Print jobs.

3. Job

Display all print files.

4. Address Book

User information can be registered,
displayed, changed, and deleted.

5. Configuration

Make system settings for the machine,
interface settings, and security.

6. Reset Device

Click to reset the printer. If a print job
is being processed, the printer will be
reset after the print job is completed.
This button is located on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator
mode.

A On Top Page, click [Login].

The window for entering the login user name and password appears.

B Enter your login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

BEB007S
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List of the Setting Items

Web Image Monitor

The following tables show Web Image Monitor items that can be viewed or mod-
ified depending on the selected mode on the Web browser.

Select one of the following modes to log on Web Image Monitor:

• User mode: log on as a user

• Administrator mode: log on as an administrator

❖ Home

• Status

• Device Info

• Counter

Menu User mode Administrator mode

Status Read Read

Ink Read Read

Input Tray Read Read

Output Tray Read Read

Menu User mode Administrator mode

Function Read Read

System Read Read

Version Read Read

Printer Language Read Read

Menu User mode Administrator mode

Copier Read Read

Printer Read Read

Fax Read Read

A3/DLT Read Read

Duplex Read Read

Send/TX Total Read Read

Fax Transmission Read Read

Scanner Send Read Read
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• Inquiry

❖ Printer: Print Jobs

❖ Job

• Job List

• Printer

• Fax History

❖ Address Book

Menu User mode Administrator mode

Machine Maintenance/Re-
pair

Read Read

Sales Representative Read Read

Consumables Read Read

Menu User mode Administrator mode

Print Job List Read/Modify Read/Modify

Menu User mode Administrator mode

Current/Waiting Jobs Read Read/Modify

Job History Read Read

Menu User mode Administrator mode

Job History Read Read

Error Log Read Read

Menu User mode Administrator mode

Transmission Read Read

Reception Read Read

LAN-Fax Read Read

Menu User mode Administrator mode

Address Book None Read/Modify
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❖ Configuration

• Device Settings

• Printer

• Fax

Menu User mode Administrator mode

System Read Read/Modify

Paper Read Read/Modify

Date/Time Read Read/Modify

Timer Read Read/Modify

Logs None Read/Modify

E-mail Read Read/Modify

Auto E-mail Notification None Read/Modify

On-demand E-mail Notifi-
cation

None Read/Modify

File Transfer None Read/Modify

User Authentication Man-
agement

None Read/Modify

Administrator Authentica-
tion Management

None Read/Modify

Program/Change Adminis-
trator

None Read/Modify

LDAP Server None Read/Modify

ROM Update None Read/Modify

Menu User mode Administrator mode

Basic Settings Read Read/Modify

Tray Parameters (PCL) None Read/Modify

Tray Parameters (PS) None Read/Modify

PDF Temporary Password Modify None

PDF Group Password None Modify

PDF Fixed Password None Modify

Menu User mode Administrator mode

General None Read/Modify

Administrator Tools None Read/Modify

E-mail Settings None Read/Modify

IP-Fax Settings None Read/Modify

IP-Fax Gateway Settings None Read/Modify

Parameter Settings None Read/Modify
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• Interface

• Network

• Security

• RC Gate

• Webpage

Menu User mode Administrator mode

Interface Settings Read Read/Modify

Menu User mode Administrator mode

IPv4 Read Read/Modify

IPv6 Read Read/Modify

NetWare Read Read/Modify

AppleTalk Read Read/Modify

SMB Read Read/Modify

SNMP None Read/Modify

SNMPv3 None Read/Modify

SSDP None Read/Modify

Bonjour Read Read/Modify

System Log Read Read

Menu User mode Administrator mode

Network Security None Read/Modify

Access Control None Read/Modify

IPP Authentication None Read/Modify

SSL/TLS None Read/Modify

ssh None Read/Modify

Site Certificate None Read/Modify

Device Certificate None Read/Modify

Menu User mode Administrator mode

Setup RC Gate None Read/Modify

Update RC Gate Firmware None Read/Modify

RC Gate Proxy Server None Read/Modify

Menu User mode Administrator mode

Webpage Read/Modify Read/Modify
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• Extended Feature Settings

Note

❒ Some items are not displayed depending on the security settings.

Displaying Web Image Monitor Help

When using Help for the first time, clicking the icon marked “?” ( ) makes
the following screen appear, in which you can view Help in two different ways,
as shown below:

❖ Viewing Help on our Web site
Downloading Help to your computer

❖ Downloading and Checking Help
You can download Help to your computer. As the Help URL, you can specify
the path to the local file to view the Help without connecting to the Internet.

Note

❒ By clicking “?” ( ), the Help icon in the header area, the contents of Help
appear.

❒ By clicking “?” ( ), the Help icon in the display area, Help for the setting
items in the display area appears.

Downloading Help

A In the [OS] list, select the operating system.

B In the [Language] list, select the language.

C Click [Download].

D Download Help by following the instructions on the screen.

E Store the downloaded compressed file in a location, and then decompress
the file.

To view the downloaded Web Image Monitor Help, set the path to the loca-
tion of the decompressed file.

Menu User mode Administrator mode

Startup Setting None Read/Modify

Extended Feature Info None Read

Install None Read/Modify

Uninstall None Read/Modify

Administrator Tools None Read/Modify

Copy Extended Features None Read/Modify

Copy Card Save Data None Read/Modify
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Linking the URL of the Help File to the [Help] Button.

You can link the URL of the help file on a computer or Web server to the [Help]
button.

A Log on to Web Image Monitor in the administrator mode.

B In the menu area, click [Configuration].

C Click [Webpage].

D In the [Set Help URL Target] box, enter the URL of the help file.

If you saved the help file to “C:\HELP\EN”, enter “file://C:/HELP/”. For
example, if you saved the file to a Web server, and the URL of the index file
is “http:// a.b.c.d/HELP/EN/index.html”, enter “http://a.b.c.d/HELP/”.

E Click [OK].
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Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers.
Also, you can change the configuration of the network interface board using
TCP/IP or IPX/SPX.

Important

❒ IPv6 cannnot be used on this function.

❖ Protocol stack provided with Operating System

• Windows 2000
TCP/IP
IPX/SPX
NetWare
Novell Client for Windows NT/2000/XP

• Windows Server 2003
TCP/IP
IPX/SPX

• Windows XP
TCP/IP
IPX/SPX
Novell Client for Windows NT/2000/XP

• Windows Vista
TCP/IP
NetWare
Novell Client for Windows NT/2000/XP/Vista

❖ Available operations
The following functions are available:

• Limits settings done from the control panel, and disables changes made to
certain items.

• Enables selection of paper type loaded in the machine.

• Switches to, and comes out of Energy Saver mode.

• Checks information about printing, paper quantity, etc.

• Simultaneously monitors multiple printers. When there are many printers,
you can create groups and classify printers to facilitate management.

• Checks the machine's network settings and detailed device information.

• Enables you to change the machine's network settings.

• You can check details of print jobs sent from a computer.

• Allows you to check job histories of printed, faxed (LAN-Fax), scanned,
and photocopied documents identified by user codes.

• Allows selection of functions such as printing and scanning for each user
code.
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• Fax numbers and e-mail addresses stored in the machine can be changed
and saved by computer.

• You can check each fax job history entry.

• You can make settings for and display the status changes of group devices.

• Using Address Management Tool, you can manage LAN-Fax numbers,
user names for Scan to Folder, and addresses for sending and receiving In-
ternet faxes.

• The e-mail sender’s name and folder can be protected.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

C Select an interface language, and then click [OK].

The following languages are available: Czech, Danish, German, English,
Spanish, French, Italian, Hungarian, Dutch, Norwegian, Polish, Portuguese ,
Finnish, Swedish, Chinese Simple and Chinese Traditional.

D Click [SmartDeviceMonitor for Admin].

E Click [Next >].

The software license agreement appears in the [License Agreement] dialog box.

F After reading through its contents, click [Yes].

G Follow the instructions on the screen.

A message appears when the installation is completed.

H Click [OK].

A message about restarting the computer may appear. Restart the computer
to complete installation.

Note

❒ Auto Run may not work under certain operating system settings. In this
case, launch “Setup.exe” located on the CD-ROM root directory.

❒ If you are required to restart the computer after installing SmartDevice-
Monitor for Admin, restart the computer and continue the configuration.
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Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configura-
tion using SmartDeviceMonitor for Admin.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a machine whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].

E  Click [Web browser], and then click [OK].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

F Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator. 

G Configure settings using Web Image Monitor.

H Click [Logout].

I Quit Web Image Monitor. 

J Quit SmartDeviceMonitor for Admin.

Locking the Menus on the Machine's Control Panel

Follow the procedure below to lock the menus on the machine's control panel.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select a machine.
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D On the [Tools] menu, point to [Device Settings], and then click [System].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

E Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your network admin-
istrator.

The [System] page of Web Image Monitor appears.

F Select [Level 1] or [Level 2] on the [Protect Printer Display Panel] in “General Set-
tings”.

G Click [OK].

H Click [Logout].

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.

Note

❒ For details about setting items, see Help in the [Device Settings] on [Configu-
ration] page.

Changing the Paper Type

Follow the procedure below to change the paper type.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a machine whose configuration you want to change.

D On the [Tools] menu, point to [Device Settings], and then click [Paper].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

E Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

The [Paper] page appears. 
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F Select a paper type in the [Paper Type] list for each tray.

Enter required setting items.

G Quit Web Image Monitor.

H Quit SmartDeviceMonitor for Admin.

Note

❒ For details about setting items, see Help in the [Device Settings] on [Configu-
ration] page.

Managing User Information

Follow the procedure below to manage the user's information using SmartDe-
viceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a machine you want to manage.

D On the [Tools] menu, click [User Management Tool].

E Enter the user name and password, and then click [OK].

For details about the user name and password, consult your network admin-
istrator.

User Management Tool starts.

Note

❒ For details about User Management Tool, see SmartDeviceMonitor for Ad-
min Help.
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Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each
user code.

A Start SmartDeviceMonitor for Admin User Management Tool.

B Click the [User Counter Information] tab of User Management Tool.

The number of pages printed under each user code appears.

C Click [Exit] on the [File] menu to quit User Management Tool.

Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages
printed under each user code as a .csv file.

A Start SmartDeviceMonitor for Admin User Management Tool.

B Click the [User Counter Information] tab of User Management Tool.

C On the [File] menu, click [Export User Statistics List].

D Specify the save location and file name, and then click [Save].

E Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0.

Follow the procedure below to reset the number of pages printed under each
user code to 0.

A Start SmartDeviceMonitor for Admin User Management Tool.

B Click the [User Counter Information] tab of User Management Tool.

C Click the user whose information you want to reset.

D On the [Edit] menu, click [Reset User Counters].

E Select the check box of the items you want to reset, and then click [OK].

A confirmation message appears.

F Click [OK].

The count for the selected paper type becomes 0 and [Modified] is displayed for
[Status].

G On the [Edit] menu, click [Apply Settings].

Changes are applied to information on the [User Counter Information] tab.

H Click [Exit] on the [File] menu to quit User Management Tool.
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Restricting Functions

Follow the procedure below to restrict use of individual functions.

A Start SmartDeviceMonitor for Admin User Management Tool.

B Click the [User Counter Information] tab of User Management Tool.

C Click the user whose functions you want to restrict.

D On the [Edit] menu of User Management Tool, click [Restrict Access To Device].

E Select the check box of the functions you want to restrict.

F Click [OK].

A confirmation message appears.

G Click [Yes].

The settings are applied.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to
them.

A Start SmartDeviceMonitor for Admin User Management Tool.

B Click the [Access Control List] tab of User Management Tool.

C On the [Edit] menu, click [Add New User].

D Enter the user code and user name.

E Select the check box of the functions applicable to the new user.

If the check boxes are unavailable, there is no restriction to use that function.

F Click [OK].

The user is added, and [New] is displayed for [Status].

G On the [Edit] menu, click [Apply Settings].

The settings are applied.

H Click [Exit] on the [File] menu to quit User Management Tool.

Note

❒ For details about setting restrictions, see SmartDeviceMonitor for Admin
Help.
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Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select the machine whose settings you want to make.

To make settings for all machines in the selected group, select no machine.

D Click the [Group] menu, point to [Energy Save Mode], [Set Individually], and then
click [On].

To select all the machines in the group, select [Set By Group].

To disable Energy Save mode, click [Off].

E Quit SmartDeviceMonitor for Admin.

Note

❒ For details about the setting for Energy Saver mode, see SmartDeviceMon-
itor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a machine whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].

E Click [Web browser], and then click [OK].

A Web browser opens and the dialog box for entering the login user name
and password for the Web Image Monitor administrator appears.
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F Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your network admin-
istrator.

G Click [Program/Change Administrator] on the [Device Settings] area, and then
change the settings.

H Click [OK].

I Click [Logout].

J Quit Web Image Monitor.

K Quit SmartDeviceMonitor for Admin.

Checking the Machine Status

Follow the procedure below to check machine status.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Click the [View] menu, and then click [Select Device List Columns].

D From [Hide:] in the [Select Device List Columns] dialog box, select the items you
want to display, and then click [Add >>]. 

Selected items will move to [Show:].

EMove all the items you want to display, and then click [OK].

An icon in the list indicates the machine’s status.

F For information about a machine’s status, select the machine you want to
know about, and then click [Open] in the [Device] menu.

The dialog box of the selected machine appears.

G Click the application whose status you want to view.

The machine’s status is displayed.

H Quit SmartDeviceMonitor for Admin.

Note

❒ For details about items in the dialog box, see SmartDeviceMonitor for Ad-
min Help.
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Changing Names and Comments

Follow the procedure below to change the names and comments of the machine.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select a machine in the list, and then click [NIB Setup Tool] on the [Tools]
menu.

D Click [Web browser], and then click [OK].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

E Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

F Click [System] on the [Device Settings] area., and then change the settings.

G Click [OK].

H Click [Logout].

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.

Note

❒ In the [Device Name] box, enter a device name on the machine using up to
31 characters.

❒ In the [Comment] box, enter a comment on the machine using up to 31 char-
acters.
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Load Fax Journal

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select a machine in the list, and then click [Load Fax Journal] on the [Tools]
menu.

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

D Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

Load Fax Journal area appears in the Web Image Monitor.

E Click [Logout].

F Quit Web Image Monitor.

G Quit SmartDeviceMonitor for Admin.

Note

❒ For details, see Help in [Load Fax Journal] area.

Viewing and Deleting Spool Print Jobs

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select a machine in the list, and then click [Spool Printing Job List(Printer)] on
the [Tools] menu.

A Web browser opens and the dialog box for entering the login user name
and password for the Web Image Monitor administrator appears.
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D Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

Spool Printing Job List appears in the Web Image Monitor.

To delete the Spool Printing Job, select the document you want to delete and
then click [Delete].

Note

❒ To display Spool Printing Job List, [Spool Printing] must be set to [Enable] on
Web Image Monitor in advance.

❒ For details, see Help in the [Spool Printing Job List] area.

Managing Address Information

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select a machine in the list, and then click [Address Management Tool] on the
[Tools] menu.

The dialog box for entering the login user name and password appears.

D Enter the login user name and password, and then click [OK].

Address Management Tool starts.

Make the necessary settings.

For details about the login user name and password, consult your network
administrator.

E Click [Logout].

F Quit Web Image Monitor.

G Quit SmartDeviceMonitor for Admin.

Note

❒ For details, see Address Management Tool Help.
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Using SmartDeviceMonitor for Client

To view the status of machines using SmartDeviceMonitor for Client, configure
SmartDeviceMonitor for Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the machine using SmartDeviceMonitor
for Client.

A Right-click the SmartDeviceMonitor for Client icon, point to [Property], and
then click [Monitor Device Settings...].

The [SmartDeviceMonitor for Client - Options] dialog box appears.

B On the [Printers Folder] tab, select the machine you want to monitor, and then
select the [To be Monitored] check box in the Monitoring Information Set-
tings area.

To display the machine status on the task bar, you must first select the [Display
on the task bar menu] check box, and then select the [Displayed on Task Bar] check
box.

C Click [OK].

The dialog box closes and the configured machine is monitored.

Note

❒ For details about status icons, see SmartDeviceMonitor for Client Help.

Checking the Machine Status

Follow the procedure below to check machine status using SmartDeviceMonitor
for Client.

A Right-click the SmartDeviceMonitor for Client icon, and then click the ma-
chine.

The machine status appears in the dialog box.

Note

❒ For details about items in the dialog box, see SmartDeviceMonitor for Cli-
ent Help.
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When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

• The network printer can only receive one print job from SmartDeviceMonitor
for Client at a time. While the network printer is printing, another user cannot
access it until the job is finished. In this case, SmartDeviceMonitor for Client
tries to access the network printer until the retry interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times
out, it will stop sending the print job. In this case, you should cancel the
paused status from the print queue window. SmartDeviceMonitor for Client
will resume access to the network printer. You can delete the print job from
the print queue window, but canceling a print job printed by the network
printer might cause the next job sent from another user to be incorrectly print-
ed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the
network printer cancels the job because something went wrong, send the
print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow, regardless of protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be the same as that in which the
jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentication is issued, enter “https://(machine's IP ad-
dress or host name)/”. Internet Explorer must be installed on your computer.
Use the highest version. Internet Explorer 6.0 or higher is recommended.

• If the [Security Alert] dialog box appears when accessing the machine using IPP
to create or configure an IPP port, or when printing, install the certificate. To
select the certificate store location when using Certificate Import Wizard,
click [Place all certificates in the following store], and then click [Local Computer]
under [Trusted Root Certification Authorities].

Note

❒ For details about SSL settings, consult your network administrator.
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Printer Status Notification by E-Mail

Whenever a paper tray becomes empty or paper is jammed, an e-mail alert is is-
sued to the registered addresses to notify the printer status.

For this notification, you can make the e-mail notification settings.

Notification timing and e-mail content can be set.

Important

❒ Depending on your e-mail application, a phishing warning might appear af-
ter you receive an e-mail message. To prevent phishing warnings appearing
after you receive e-mail from a specified sender, you must add the sender to
your e-mail application's exclusion list. For details about how to do this, see
your e-mail application's Help.

You can be notified of the following events:

• Service call.

• Print cartridge is empty.

• Print cartridge is nearly empty.

• Ink collection bottle (back) is full.

• Ink collection bottle (back) is nearly full.

• Ink collection bottle (front) is full.

• Ink collection bottle (front) is nearly full.

• Paper has jammed.

• Open door is detected.

• The paper tray is empty.

• The paper tray is nearly empty.

• A paper tray error occurred.

• Output paper tray is full.

• Unit connection error.

• Duplex unit error.

• Hard disk drive is full.
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Note

❒ When the service call is set, follwing call results can be sent.

• Failure automatic call success

• Failure automatic call out of time

• Failure automatic call failure

• Consumable automatic call success

• Remote machine check failure

• Firmware update confirmed

❒ Other call results can be displayed, depending on the machine type.

❒ For details about the service call, contact your service or sales representa-
tive.

A Log on to Web Image Monitor in administrator mode.

B In the menu area, click [Configuration].

C Click [E-mail] on the [Device Settings] area.

DMake the following settings:

• Items in the Reception column: Make the necessary settings for sending
and receiving e-mail. 

• Items in the SMTP column: Configure the SMTP server. Check your mail-
ing environment, and then specify the necessary items. You can also per-
form mail authentication for the SMTP server.

• Items in the POP before SMTP column: Configure the POP server. Check
your mailing environment, and then specify the necessary items. You can
also perform mail authentication for the POP server.

• Items in the POP3/IMAP4 column: Configure the POP3 or IMAP4 server.
Check your mailing environment, and then specify the necessary items.

• Items in the E-mail Communication Port column: Configure the port to be
used for access to the mail server.

• Items in the Fax E-mail Account column Port column: Specify internet fax
addresses, user names, and password settings..

• Items in the E-mail Notification Account column: Specify these items if you
want to use on-demand e-mail notification.

E Click [OK].

F Click [Logout].

G Quit Web Image Monitor.
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Auto E-mail Notification

A Log on to Web Image Monitor in administrator mode.

B Click [Configuration] in the menu area, and then click [Auto E-mail Notification]
on the [Device Settings] area.

The dialog box for making notification settings appears.

CMake the following settings:

• Notification Message: You can set this according to your needs, for exam-
ple, the machine's location, service representative contact information.

• Items in the Groups to Notify column: E-mail notification addresses can be
grouped as required.

• Items in the Select Groups/Items to Notify column: Select groups for each
notification type, such as machine status and error.
To make detailed settings for these items, click [Edit] next to [Detailed Set-
tings of Each Item].

D Click [OK].

E Click [Logout].

F Quit Web Image Monitor.
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On-demand E-mail Notification

This function allows you to receive machine status e-mail reports by sending a
request e-mail to the machine.

Use the following procedure to configure On-demand E-mail Notification.

A Log on to Web Image Monitor in administrator mode.

B Click [Configuration] in the menu area, and then click [On-demand E-mail Notifi-
cation] on the [Device Settings] area.

The dialog box for making notification settings appears.

CMake the following settings:

• Notification Subject: Enter a text string to be added to the subject line of re-
turn e-mails.

• Items in Notification Message column: You can set this according to your
needs, for example, the machine's location, service representative contact
information.

• Items in the Access Restriction to Information column: Select whether to
restrict accesses based on a specific category of information.

• Items in the Receivable E-mail Address/Domain Name Settings column:
Enter an e-mail address or domain name to use for requesting information
by e-mail and to receive its return e-mail.

D Click [OK].

E Click [Logout].

F Quit Web Image Monitor.
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Mail authentication

You can configure mail authentication to prevent illegal use of the mail server.

❖ SMTP Authentication
Specify SMTP authentication.
When mail is sent to the SMTP server, authentication is performed using the
SMTP AUTH protocol by prompting the mail originator to enter the user
name and password.This prevents illegal use of the SMTP server.

A Log on to Web Image Monitor in administrator mode.

B Click [Configuration] in the menu area, and then click [E-mail] on the [Device
Settings] area.

C Make the following settings in SMTP column:

• SMTP Server Name: Enter the IP address or host name of the SMTP
server

• SMTP Port No.: Enter the port number used when sending e-mail to the
SMTP server.

• SMTP Authentication: Enable or disable SMTP authentication.

• SMTP Auth. E-mail Address: Enter the e-mail address.

• SMTP Auth. User Name: Enter the SMTP account name.

• SMTP Auth. Password: To set or change the password for SMTP AUTH.

• SMTP Auth. Encryption: Select whether to encrypt the password or not. 
[Encryption]-[Auto Select]: If the authentication method is PLAIN,
LOGIN, CRAM-MD5, or DIGEST-MD5.
[Encryption]-[Enable]: If the authentication method is CRAM-MD5 or DI-
GEST-MD5.
[Encryption]-[Disable]: If the authentication method is PLAIN or LOGIN.

D Click [OK]

E Click [Logout].

F Quit Web Image Monitor.
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❖ POP before SMTP Authentication
Select whether to log on to the POP3 server before sending e-mail.

A Log on to Web Image Monitor in administrator mode.

B Click [Configuration] in the menu area, and then click [E-mail] on the [Device
Settings] area.

C Make the following settings in POP before SMTP column:

• POP before SMTP: Enable or disable POP before SMTP.

• POP E-mail Address: Enter the e-mail address.

• POP User Name: Enter the POP account name.

• POP Password: To set or change the POP password.

• Timeout setting after POP Auth.: Enter the time available before con-
necting to the SMTP server after logging on to the POP server. 

D Click [OK].

E Click [Logout].

F Quit Web Image Monitor.

Sending E-mail Notification

To use on-demand e-mail notification, perform the following configuration
tasks in Web Image Monitor.

A Log on to Web Image Monitor in administrator mode.

B Click [Configuration] in the menu area, and then click [E-mail] on the [Device Set-
tings] area.

C Make the following settings:

• E-mail Notification E-mail Address: Enter the address using alphanumeric
characters.

• Receive E-mail Notification: Specify whether to use on-demand e-mail no-
tification.

• E-mail Notification User Name: Enter the administrator's user name as the
mail originator name.

• E-mail Notification Password: Enter the password of the mail notification
user.

D Click [OK].

E Click [Logout].

F Quit Web Image Monitor.
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❖ Format of on-demand e-mail messages
To use mail notification, you need to send an on-demand e-mail message to
this machine.
Using your mail software, enter the following:

Note

❒ A mail message must be within 1 MB in size.

❒ E-mail may be incomplete if sent immediately after power on.

❖ Subject field
Format: devicestatus?parameter-name=parameter[&=parameter][&=param-
eter]...

Note

❒ The Subject field is case-insensitive.

❒ Parameter names can be written in any order.

❖ Subject field coding examples

❖ Parameters

Item Description

Subject (Referred to as Subject) Enter a request regarding the device. For de-
tails, see the table below.

From (Referred to as From) Specify a valid mail address. The device in-
formation will be sent to the address speci-
fied here.

Coding example Action

devicestatus?request=sysconfig&for-
mat=text&lang=en

The device's system configuration informa-
tion will be sent in an English text format.

devicestatus?request=sysconfig The device's system configurationinforma-
tion will be sent in a preset format and lan-
guage.

Parameter Meaning Default

request Information to be obtained Mandatory

format Mail format Mail will be sent in the for-
mat preset for each mail ad-
dress.

lang Language for mail body Mail will be sent in the lan-
guage preset for each mail 
address.
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❖ Parameters specifying the information to be obtained

❖ Parameters specifying the mail format

Note

❒ HTML and XML can be seleceted for subject field, but output is text only.

Information to be obtained Parameter

System configuration information sysconfig

Network configuration information netconfig

Printer configuration information prtconfig

Supplies information supply

Device status information status

Mail format Parameter

Text text

HTML html

XML xml
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❖ Parameters that specify the language for mail bodies

Note

❒ For the language used in the body of the mail, you can select either English
or the language in which the control panel items are displayed. For exam-
ple: if the control panel items are displayed in German, you can select ei-
ther German or English.

Language Parameter

Language in which control panel items are 
displayed

German

French

Italian

Dutch

Spanish

Danish

Finnish

Norwegian

Portuguese

Swedish

Czech

Hungarian

Polish

Russian

Catalan

Turkish

Simplified Chinese

Traditional Chinese

Korean

de

fr

it

nl

es

da

fi

no

pt

sv

cs

hu

pl

ru

ca

tr

cn

tw

ko

English en
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Remote Maintenance by telnet

Important

❒ Remote Maintenance should be password-protected so that access is allowed
to administrators only. 

❒ The password is the same as the one of Web Image Monitor administrator.
When the password is changed using “mshell”, other passwords change also.

❒ Some command cannot be set depending on the model type.

Using telnet

Follow the procedure below to use telnet.

Important

❒ Only one user at a time can log on to perform remote maintenance.

❒ If you are using Windows Vista, you must enable the telnet server and telnet
client beforehand.

A Use the IP address or the host name of the machine to start telnet.

% telnet IP_address

B Enter your user name and password.

For details about the user name and password, consult your network admin-
istrator.

For user authentication, enter a login user name and password.

For user code authentication, enter a user code in User Name.

C Enter a command.

D Quit telnet.

msh> logout

The configuration message about saving the changes appears.

E Enter “yes” to save the changes, and then press the {Enter} key.

If you do not want to save the changes, enter “no”, and then press the {Enter}
key. To make further changes, enter “return” at the command line, and then
press the {Enter} key.
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Note

❒ If the message “Can not write NVRAM information” appears, the changes
are not saved. Repeat the procedure above.

❒ When the changes are saved, the network interface board is reset automat-
ically with that changes.

❒ When the network interface board resets, the print job in print process will
be printed. However, print jobs in queue will be canceled.

❒ To use Telnet under Windows Vista, SmartDeviceMonitor for Client must
be installed.

access

Use the “access” command to view and configure access control. You can also
specify two or more access ranges.

❖ View settings

msh> access

❖ IPv4 configration display

msh> access ID range

❖ IPv6 configuration display

msh> access ID range6

❖ IPv6 access mask configuration display

msh> access ID mask6

❖ IPv4 Configuration

msh> access ID range “start-address end-address”
Example: to specify accessible IPv4 addresses between 192.168.0.10 and
192.168.0.20:

msh> access 1 range 192.168.0.10 192.168.0.20

❖ IPv6 Configuration

msh> access ID range6 “start-address end-address”
Example: to specify accessible IPv6 addresses between 2001:DB8::100 and
2001:DB8::200.

msh> access 1 range6 2001:DB8::100 2001:DB8::200

❖ IPv6 access mask configuration

msh> access ID mask6 “base-address prefixlen”
Example: to specify accessible IPv6 addresses to 2001:DB8::/32 

msh> access 1 mask6 2001:DB8:: 32
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❖ Access control initialization 

msh> access flush

• Use the “flush” command to restore the default settings so that all access
ranges become “0.0.0.0” for IPv4, and “::” for IPv6.

Note

❒ For IPv4 and IPv6, you can select an ID number between 1 and 5.

❒ You can specify each IPv6 entry by either range or mask. For the range param-
eter, you can select “start-address end-address”. For the mask parameter, you
can select “baseaddress prefixlen”.

❒ The access range restricts computers from use of the machine by IP address.
If you do not need to restrict printing, make the setting “0.0.0.0” for IPv4, and
“::” for IPv6.

❒ Valid ranges must be from lower (start address) to higher (end address).

❒ IPv6 can register and select the range and the mask for each access ranges.

❒ IPv6 mask ranges between 1 - 128 can be selected.

❒ Up to five access ranges can be specified. The entry is invalid if the target
number is omitted.

❒ You cannot send print jobs, or access Web Image Monitor and diprint from a
restricted IP address.

appletalk

Use the “appletalk” command to view and configure AppleTalk parameters.

❖ View settings

msh> appletalk

•  [2] means “active” and [0] means “inactive”.

• The default is [2].

❖ Changing PAP timeout configuration

msh> appletalk ptimeout value > 0

• Timeout value becomes effective.

msh> appletalk ptimeout value = 0

• Timeout value becomes ineffective.
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authfree

Use the “authfree” command to display and configure authentication exclusion
control settings.

❖ View Settings

msh> authfree
If print job authentication exclusion is not set, authentication exclusion con-
trol cannot be displayed.

❖ IPv4 address settings

msh> authfree “ID” range_addr1 range_addr2

❖ IPv6 address settings

msh> authfree “ID” range6_addr1 range6_addr2

❖ IPv6 address mask settings

msh> authfree “ID” mask6_addr1 masklen

❖ Parallel/USB settings

msh> authfree [parallel|usb] [on|off]
To enable authfree, set to “on”. To disable authfree, set to “off”.
Always specify the interface.

❖ Authentication exclusion control initialization

msh> authfree flush

Note

❒ For IPv4 and IPv6, up to five access ranges can be registered and selected.

autonet

Use the “autonet” command to configure AutoNet parameters.

❖ View settings
The following command displays the current AutoNet settings:

msh> autonet

❖ Configuration
You can configure AutoNet settings.

msh> autonet {on|off}

•  {on} means “active” and {off} means “inactive”.

❖ Current interface priority configuration display

msh> autonet priority
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❖ Interface priority configuration

msh> autonet priority “interface_name”

• You can give interface's AutoNet parameter priority.

• Priority settings are available when multiple interfaces are installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Note

❒ If an interface is not selected, the current interface connection settings remain
in effect.

❒ For details about AutoNet, refer to autonet parameters.

bonjour (rendezvous)

Use the “bonjour (rendezvous)” command to display bonjour (rendezvous)-re-
lated settings.

❖ View settings
Bonjour settings are displayed.

msh> bonjour

❖ Bonjour service name setting
You can specify the bonjour service name.

msh> bonjour cname “computer name”

• The computer name can be entered using up to 63 alphanumeric charac-
ters.

•  If you do not specify a character string, the current setting is displayed.

❖ Bonjour Installation location information setting
You can enter information about the location where the printer is installed.

msh> bonjour location “location”

• Information about location can be entered using up to 32 alphanumeric
characters.

• If you do not specify a character string, the current setting is displayed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ Setting order of priority for each protocol

• diprint

msh> bonjour diprint [0–99]

• lpr

msh> bonjour lpr [0–99]

• ipp

msh> bonjour ipp [0–99]
You can specify the order of priority for “diprint”, “lpr”, and “ipp”. Smaller
numbers indicate higher priority.

❖ IP TTL setting

msh> bonjour ip ttl [1–255]
You can specify the IP TTL (the number of routers a packet can pass through). 

Note

❒ The default is 255.

❖ Resetting the computer name and location information
You can reset the computer name and location information.

msh> bonjour clear {cname|location}

• cname
Reset the computer name. The default computer name will be displayed
when the computer is restarted.

• location
Reset the location information. The previous location information will be
deleted.

❖ Interface configuration

msh> bonjour linklocal “interface_name”

• If many types of interface are installed, configure the interface that com-
municates with linklocal address.

• If you do not specify an interface, the Ethernet interface is selected auto-
matically.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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btconfig

Use the “btconfig” command to make Bluetooth settings.

❖ View settings
Bluetooth settings are displayed.

msh> btconfig

❖ Mode settings
You can set the Bluetooth operation mode to {private} or {public}.

msh> btconfig {private|public}

• The default is {public}.

devicename

Use the “devicename” command to display and change the printer name.

❖ View settings

msh> devicename

❖ Printer name configuration

msh> devicename name “string”

• Enter a printer name using up to 31 alphanumeric characters.

• Set single names for each printer.

❖ Printer name initialization

msh> devicename clear name

• Reset the printer name to its default.
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dhcp

Use the “dhcp” command to configure DHCP settings.

❖ View settings
The following command displays the current DHCP settings.

msh> dhcp

❖ Configuration
You can configure DHCP.

msh> dhcp “interface_name” {on|off}

• Click {on} to enable dhcp. Click {off} to disable DHCP.

• If the DNS server address and domain name are obtained from DHCP, be
sure to click {on}.

• wlan can be specified only when the IEEE 802.11 interface is installed.

❖ Current interface priority configuration display

msh> dhcp priority

❖ Interface priority configuration

msh> dhcp priority “interface_name”

• You can select which interface has DHCP parameter priority.

• Priority settings are available when multiple interfaces are installed.

❖ DNS server address selection

msh> dhcp dnsaddr {dhcp|static}

• Specify whether to obtain the DNS server address from the DHCP server
or use the address set by a user. 

• To obtain the DNS server address from the DHCP server, specify “dhcp”.
To use the address set by a user, specify “static”. 

❖ Domain name selection

msh> dhcp domainname {dhcp|static}

• Specify whether to obtain the domain name from the DNS server or use the
domain name set by a user.

• To obtain the domain name from the DHCP server, specify “dhcp”. To use
the domain name set by a user, specify “static”.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface
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Reference

p.126 “Using DHCP”

p.63 “dns”

p.65 “domainname”

diprint

The direct printing port enables direct printing from a network-connected com-
puter.

Use the “diprint” command to change direct printing port settings.

❖ View settings
The following command displays the current direct printing port settings:

msh> diprint
Example output:

port 9100
timeout=300(sec)
bidirect on
con multi
apl async

• The “port” specifies the port number of the direct printing port.

• The “bidirect” setting indicates whether the direct printing port is bidirec-
tional or not.

❖ Setting timeout

msh> diprint timeout [30~65535]

• You can specify the timeout interval to use when the printer is expecting
data from the network.

• The default is 300 seconds.

❖ Specifying the number of concurrent connections

msh> diprint con {multi|single}

• The above command specifies the number of concurrent diprint connec-
tions. Specify “multi” for multiple connections or “single” for a single con-
nection.

• The default is “multi”.
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dns

Use the “dns” command to configure or display DNS (Domain Name System)
settings.

❖ View settings
The following command displays current DNS settings:

msh> dns

❖ IPv4 DNS server configuration
The following command enables or disables the IPv4 DNS server address:

msh> dns “number” server “server address”
The following command displays a configuration using the IP address
192.168.15.16 on a DNS 1 server:

msh> dns 1 server 192.168.15.16

• You can register IPv4 DNS Server address.

• You can select an ID number between 1 and 3. You can select up to three
ID numbers.

• You cannot use “255.255.255.255” as the DNS server address.

❖ IPv6 DNS server configuration
The following command enables or disables the IPv4 DNS server address:

msh> dns “ID” server6 “server address”

• You can register IPv6 DNS Server address.

• You can select an ID number between 1 and 3. You can select up to three
ID numbers.

❖ Dynamic DNS function setting

msh> dns “interface_name” ddns {on|off}

• You can set the dynamic DNS function “active” or “inactive”.

• {on} means “active” and {off} means “inactive”.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ Specifying the record overlap operation

msh> dns overlap {update|add}

• You can specify operations performed when records overlap.

• update
To delete old records and register new records.

• add
To add new records and store the old records.

• When CNAME overlaps, it is always changed, irrespective of settings.

❖ CNAME registration

msh> dns cname {on|off}

• You can specify whether to register CNAME.

• {on} means “active” and {off} means “inactive”.

• The CNAME registered is the default name beginning with rnp. CNAME
cannot be changed.

❖ A records registration

msh> dns arecord {dhcp|own}

• {dhcp}
You can specify the method of registering an A record when the dynamic
DNS function is enabled and DHCP is used.

• {own}
To register an A record using the printer as the DNS client.
The DNS server address and the domain name already designated are
used for the registration.

❖ Record updating interval settings

msh> dns interval [1–255]

• You can specify the interval after which records are updated when using
the dynamic DNS function.

• The updating interval is specified hourly. It can be entered between 1 and
255 hours.

• The default is 24 hours.

❖ resolv.conf display

msh> dns resolv

❖ Specifying the protocol when asking names during dual stacking

msh> dns resolv protocol {ipv4|ipv6}

• Appears during dual stacking only.
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domainname

Use the “domainname” command to display or configure the domain name set-
tings.

You can configure the Ethernet interface, or IEEE 802.11b interface.

❖ View settings
The following command displays the current domain name:

msh> domainname

❖ Interface domain configuration

msh> domainname “interface_name”

❖ Setting the Domain Name

msh> domainname “interface_name” name “domain name”

• A domain name can be entered using up to 63 alphanumeric characters.

• The Ethernet interface and IEEE 802.11b interface will have the same do-
main name.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Deleting the Domain Name

msh> domainname “interface_name” clear name

help

Use the “help” command to display the available command list and the proce-
dures for using those commands.

❖ Command list display

msh> help

❖ Display of procedure for using commands

msh> help “command_name”

Interface Interface set

ether Ethernet interface

wlan IEEE 802.11b interface
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hostname

Use the “hostname” command to change the printer name.

❖ View settings

msh> hostname

❖ IPv4 Configuration

msh> hostname “interface_name ” “printer_name”

• Enter the printer name using up to 63 alphanumeric characters.

• You cannot use a printer name beginning “RNP” (in either upper or lower
case).

• The Ethernet interface and IEEE 802.11b interface will have the same print-
er name.

• wlan can be specified only when the IEEE 802.11b interface is installed.

• If you do not specify an interface, the Ethernet interface is selected auto-
matically .

❖ Initializing the printer name for each interface

msh>hostname “interface_name” clear name

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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ifconfig

Use the “ifconfig” command to view and configure TCP/IP (IP address, subnet
mask, broadcast address, default gateway address) for the printer.

❖ View settings

msh> ifconfig

❖ IPv4 Configuration

msh> ifconfig “interface_name” “parameter” “address”

• If you did not enter an interface name, it is automatically set to the Ethernet
interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

The following explains how to configure an IPv4 address 192.168.15.16 on
Ethernet interface.

msh> ifconfig ether 192.168.15.16

❖ IPv6 Configuration

msh> ifconfig ether inet6 interface_name ” “printer_name”
The following explains how to configure a IPv6 address to 2001:DB8::100 with
prefix length 64 on the Ethernet interface.

msh> ifconfig ether inet6 2001:DB8::100 64

❖ Netmask configuration

msh> ifconfig “interface_name” netmask “address”
The following explains how to configure a subnet mask 255.255.255.0 on Eth-
ernet interface.

msh> ifconfig ether netmask 255.255.255.0

❖ Broadcast address configuration

msh> ifconfig “interface_name” broadcast “address”

❖ Changing the Interface

msh> ifconfig “interface” up

• You can specify either the Ethernet interface or IEEE 802.11b interface
when using the optional IEEE 802.11b interface unit.

Interface name Interface configured

ether Ethernet Interface

wlan IEEE 802.11b Interface
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Note

❒ To get the above addresses, contact your network administrator.

❒ Use the default configuration if you cannot obtain setting addresses.

❒ The IP address, subnet mask and broadcast address are the same as that for
the ethernet interface and IEEE 802.11b interface.

❒ TCP/IP configuration is the same for both Ethernet and IEEE 802.11 interface.
If interfaces are changed, the new interface inherits the configuration.

❒ Use “0x” as the initial two letters of a hexadecimal address.

info

Use the “info” command to display printer information such as paper tray, out-
put tray, and printer language.

❖ Printer information display

msh> info

Reference

p.91 “Getting Printer Information over the Network”

ipp

Use the “ipp” command to view and configure IPP settings.

❖ Viewing settings
The following command displays the current IPP settings:

msh> ipp

❖ IPP timeout configuration 
Specify how many seconds the computer waits before canceling an interrupt-
ed print job. The time can be entered between 30 to 65535 seconds.

msh> ipp timeout [30 - 65535]

❖ IPP user authorization configuration
Use IPP user authorization to restrict users to print with IPP. The default is
“off”.

msh> ipp auth {basic|digest|off}

• User authorization settings are “basic” and “digest”.

• If user authorization is specified, register a user name. You can register up
to 10 users.
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❖ IPP user configuration
Configure IPP users according to the following messages:

msh> ipp user
The following message appears:

msh> Input user number (1 to 10):
Enter the number, user name, and password.

msh> IPP user name:user1
msh> IPP password:*******
After configuring the settings, the following message appears:

User configuration changed.

ipv6

Use the “ipv6” command to display and configure IPv6 settings.

❖ View Setting

msh> ipv6

❖ IPv6 stateless address

msh> ipv6 stateless {on|off}
If “on” is selected, IPv6 requests information required for maintaining state-
ful connection to the router for as long as the printer power is turned on. This
setting allows information from the router to be obtained constantly, and pe-
riodically refreshes the effective period of the stateless address.

lpr

Use the “lpr” command to view and configure LPR settings.

❖ View Setting

msh> lpr

❖ Checking host name when deleting the job

msh> lpr chkhost {on|off}
If “on” is selected, you can delete print jobs only from the IP address of the
host that sent the print job. If LPR is disabled, you can also delete print jobs
sent from IP addresses other than that of the host.

❖ Printer Error Detection Function

lpr prnerrchk {on|off}
If you set this to “on”, the printer stops receiving data and will wait until the
error is resolved before continuing processing a job.
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netware

Use the “netware” command to view and configure the NetWare settings such
as the print server name or file server name.

❖ NetWare Printer Server Names

msh> netware pname character string

• Enter the NetWare print server name using up to 47 characters.

❖ NetWare File Server Names

msh> netware fname character string

• Enter the NetWare file server name using up to 47 characters.

❖ Encap type

msh> netware encap {802.3|802.2|snap|ethernet2|auto}

❖ Remote Printer Number

msh> netware rnum {0–254}

• The default is 0.

❖ Timeout

msh> netware timeout {3–255}

• The default is 15.

❖ Printer server mode

msh> netware mode pserver
msh> netware mode ps

❖ Remote printer mode

msh> netware mode rprinter
msh> netware mode rp

❖ NDS context name

msh> netware context character string

❖ SAP interval

msh> netware “sap_interval[0–3600]”
It can be entered between 0 and 3600 seconds.

❖ Setting login mode for file server

msh> netware login server

❖ Setting login mode for NDS tree

msh> netware login tree
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❖ Setting login mode for NDS tree name

msh> netware tree “NDS name”

❖ File transfer protocol

msh> netware trans {ipv4pri|ipxpri|ipv4|ipx}

• If you do not specify the protocol, the current setting is displayed. 

passwd

Use the “passwd” command to change the remote maintenance password.

❖ Changing the Password

msh> passwd

• Enter the current password.

• Enter the new password.

• Renter the new password to confirm it.

❖ Changing the Password of the administrators using the Supervisor

msh> passwd {Administrator ID}

• Enter the new password.

• Renter the new password to confirm it.

Note

❒ Be sure not to forget or lose the password.

❒ The password can be entered using up to 32 alphanumeric characters. Pass-
words are case-sensitive. For example, “R” is not the same as “r”.

Protocol Set Protocol

ipv4pri IPv4+IPX(IPv4)

ipxpri IPv4+IPX(IPX)

ipv4 IPv4

ipx IPX
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prnlog

Use the “prnlog” command to obtain printer log information.

❖ Print logs display

msh> prnlog

• Display previous print jobs.

msh> prnlog “ID Number”

• Specify the ID number of the displayed print log information to display ad-
ditional details about a print job.

Reference

p.91 “Getting Printer Information over the Network”.

route

Use the “route” command to view and control the routing table.

❖ Specified route information display

msh> route get “destination”

• Specify the IPv4 address to destination.
“0.0.0.0” cannot be specified as destination address.

❖ Enabling/disabling specified IPv4 destination

msh> route active {host|net} “destination” {on|off}

• If you do not specify {host|net}, the host setting is selected automatically.

❖ Adding IPv4 Routing Table

msh> route add {host|net} “destination” “gateway”

• Adds a host or network route to “destination”, and a gateway address to
“gateway” in the table. 

• Specify the IPv4 address to destination and gateway.

• If you do not specify {host|net}, the host setting is selected automatically.

• You cannot specify“0.0.0.0” as the destination address.

❖ Setting the Default IPv4 Gateway

msh> route add default “gateway”

❖ Deleting specified IPv4 destination from Routing Table

msh> route delete {host|net} “destination”

• If you do not specify {host|net}, the host setting is selected automatically.

• IPv4 address of destination can be specified.
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❖ Setting IPv6 Default Gateway

msh> route add6 default gateway

❖ Adding a specified IPv6 destination to Routing Table

msh> route add6 “destination” “prefixlen[1–128]” “gateway”
prefixlen gateway

• Specify the IPv6 address to destination and gateway.

• If the prefix of the address is between 1 and 127, the network is selected. If
the prefix of the address is 128, the host is selected.

• You cannot register a record that has the same destination and prefix as a
registered record.

• You cannot register a record that uses “0000:0000:0000:0000:0000:0000:0000:0000”
as its destination.

❖ Deleting a specified IPv6 destination from Routing Table

msh> route delete6 “destination” “prefixlen”

• Specify the IPv6 address to destination and gateway.

❖ Display information about a specified IPv6 route information

msh> route get6 “destination”

• Specify the IPv6 address to destination and gateway.

❖ Enabling/disabling a specified IPv6 destination

msh> route active6 “destination” “prefixlen[1–128]” {on|off}

❖ Route initialization

msh> route flush

Note

❒ The maximum number of IPv4 routing tables is 16.

❒ The maximum number of IPv6 routing tables is 2.

❒ Set a gateway address when communicating with devices on an external net-
work.

❒ The same gateway address is shared by all interfaces.

❒ “Prefixlen” is a number between 1 and 128.
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set

Use the “set” command to set the protocol information display “active” or “inactive”.

❖ View settings
The following command displays protocol information (active/inactive).

msh> set ipv4

msh> set ipv6

msh> set appletalk

msh> set netware

msh> set smb

msh> set protocol

• When protocol is specified, information about TCP/IP, AppleTalk, Net-
Ware, PictBridge and SMB appears.

msh> set lpr

msh> set lpr6

msh> set ftp

msh> set ftp6

msh> set rsh

msh> set rsh6

msh> set diprint

msh> set diprint6

msh> set web

msh> set snmp

msh> set ssl

msh> set ssl6

msh> set nrs

msh> set rfu

msh> set rfu6

msh> set ipp

msh> set ipp6

msh> set http

msh> set http6

msh> set bonjour

msh> set nbt

msh> set ssdp

msh> set ssh

msh> set sftp

msh> set sftp6
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❖ Configuration

• Enter “up”to enable protocol, and enter “down” to disable protocol.
You can set the protocol to “active” or “inactive”.

msh> set ipv4 {up|down}

• If you disable IPv4, you cannot use remote access after logging off. If you
did this by mistake, you can use the control panel to enable remote access
via IPv4.

• Disabling IPv4 also disables lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http,
bonjour, and sftp

msh> set ipv6 {up|down}

• If you disable IPv6, you cannot use remote access after logging off. If you
did this by mistake, you can use the control panel to enable remote access
via IPv6.

• Disabling IPv6 also disables lpr6, ftp6, rsh6, diprint6, ssl6, ipp6, http6, bon-
jour 6, wsdev, and sftp6.

msh> set appletalk {up|down}

msh> set netware {up|down}

msh> set smb {up|down}

msh> set lpr {up|down}

msh> set lpr6 {up|down}

msh> set ftp {up|down}

msh> set ftp6 {up|down}

msh> set rsh {up|down}

msh> set rsh6 {up|down}

msh> set diprint {up|down}

msh> set diprint6 {up|down}

msh> set web {up|down}

msh> set snmp {up|down}

msh> set ssl {up|down}

msh> set ssl6 {up|down}

• If Secured Sockets Layer (SSL, an encryption protocol) function is not
available for the printer, you cannot use the function by enabling it.

msh> set nrs {up|down}

msh> set rfu {up|down}

msh> set rfu6 {up|down}

msh> set ipp {up|down}

msh> set ipp6 {up|down}

msh> set http {up|down}

msh> set http6 {up|down}

msh> set bonjour {up|down}
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msh> set ssh {up|down}

msh> set ssdp {up|down}

msh> set nbt {up|down}

msh> set sftp {up|down}

msh> set sftp6 {up|down}

show

Use the “show” command to display network interface board configuration set-
tings.

❖ View settings

msh> show

• If “-p” is added, you can view settings one by one.

Reference

p.99 “Configuring the Network Interface Board”

slp

Use “slp” command to view and configure SLP settings.

msh> slp ttl “ttl_val[1–255]”

• You can search the NetWare server using SLP in the PureIP environment of
NetWare 5/5.1. Using the “slp” command, you can configure the value of
TTL which can be used by SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local seg-
ment. If the router does not support multicast, the settings are not available
even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.

smb

Use the “smb” command to configure or delete the computer or workgroup
name for SMB.

❖ Computer Name settings 

msh> smb comp “computer name”

• Set computer name using up to 15 characters. Names beginning with
“RNP” or “rnp” cannot be entered.

❖ Working Group Name settings

msh> smb group “work group name”

• Set workgroup name using up to 15 characters
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❖ Comment settings

msh> smb comment “comment”

• Set comment using up to 31 characters.

❖ Notify print job completion

msh> smb notif {on|off}

• To notify print job completion, specify “on”. Otherwise, specify “off”

❖ Deleting Computer Name

msh> smb clear comp

❖ Deleting Group Name

msh> smb clear group

❖ Deleting Comment

msh> smb clear comment

❖ View Protocol

msh> smb protocol 

snmp

Use the “snmp” command to display and edit SNMP configuration settings such
as the community name.

❖ View settings

msh> snmp

• Default access settings 1 is as follows:
Community name:public
IPv4 address:0.0.0.0
IPv6 address:::
IPX address:00000000:000000000000
Access type:read-only
Effective Protocol:IPv4/IPv6/IPX

• Default access settings 2 is as follows:
Community name:admin
IPv4 address:0.0.0.0
IPv6 address:::
IPX address:00000000:000000000000
Access type:read-write
Effective Protocol:IPv4/IPv6/IPX

• If “-p” is added, you can view settings one by one.

• To display the current community, specify its registration number.
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❖ Display

msh> snmp ?

❖ Community name configuration

msh> snmp “number” name “community_name”

• You can configure ten SNMP access settings numbered 1-10.

• The printer cannot be accessed from SmartDeviceMonitor for Admin or
SmartDeviceMonitor for Client if “public” is not registered in numbers 1-
10. When changing the community name, use SmartDeviceMonitor for
Admin and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.

❖ Deleting community name

msh> snmp “number” clear name

❖ Access type configuration

msh> snmp “number” type “access_type”

❖ Protocol configuration
Use the following command to set protocols “active” or “inactive”: If you set
a protocol “inactive”, all access settings for that protocol are disabled.

msh> snmp {ipv4|ipv6|ipx} {on|off}

• Specify “ipv4” for IPv4, “ipv6” for IPv6, or “ipx” for IPX/SPX.

• {on} means “active” and {off} means “inactive”.

• All protocols cannot be turned off concurrently.

❖ Configuration of protocol for each registration number

msh> snmp “number” active {ipv4|ipv6|ipx} {on|off}

• To change the protocol of access settings, use the following command.
However, if you have disabled a protocol with the above command, acti-
vating it here has no effect.

Access type Type of access permission

no not accessible

read read only

write read and write

trap user is notified of trapmessages
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❖ Access configuration

msh> snmp “number” {ipv4|ipv6|ipx} “address”

• You can configure a host address according to the protocol used.

• The network interface board accepts requests only from hosts that have
IPv4, IPv6, and IPX addresses with access types of “read-only” or “read-
write”. Enter “0” to have network interface board accept requests from any
host without requiring a specific type of access.

• Enter a host address to deliver “trap” access type information to.

• To specify IPv4 or IPv6, enter “ipv4” or “ipv6” followed by a space, and
then the IPv4 or IPv6 address.

• To specify IPX/SPX, enter “ipx” followed by a space, the IPX address fol-
lowed by a decimal, and then the MAC address of the network interface
board.

❖ sysLocation configuration

msh> snmp location

❖ Deleting sysLocation

msh> snmp clear location

❖ sysContact setting

msh> snmp contact

❖ Deleting sysContact

msh> snmp clear contact

❖ SNMP v1v2 function configuration

msh> snmp v1v2 {on|off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP v3 function configuration

msh> snmp v3 {on|off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP TRAP configuration

msh> snmp trap {v1|v2|v3} {on|off}

• Specify “on” to enable, and “off” to disable.

❖ Remote Configuration Authorization configuration

msh> snmp remote {on|off}

• Specify “on” to enable, and “off” to disable the SNMP v1v2 setting.
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❖ SNMP v3 TRAP configuration display

msh> snmp v3trap

msh> snmp v3trap {1-5}

• If a number from 1-5 is entered, settings are displayed for that number only.

❖ Configuring a sending address for SNMP v3 TRAP

msh> snmp v3trap {1-5} {ipv4|ipv6|ipx} “address”

❖ Configuring a sending protocol for SNMP v3 TRAP

msh> snmp v3trap {1-5} active {ipv4|ipv6|ipx} {on|off}

❖ Configuring a user account for SNMP v3 TRAP

msh> snmp v3trap {1-5} account “account_name”

• Enter an account name using up to 32 alphanumeric characters.

❖ Deleting an SNMP v3 TRAP user account

msh> snmp v3trap {1-5} clear account

❖ Configuring an SNMP v3 encryption algorithm

msh> snmp v3auth {md5|sha1}

❖ Configuring SNMP v3 encryption

msh> snmp v3priv {auto|on}

• Set “auto” for automatic encryption configuration

• If you select “on”, plain-text communication becomes impossible - only en-
crypted communication is possible.

Note

❒ Encryptable implies situation when the machine's encrypted password is set.

sntp

The printer clock can be synchronized with a NTP server clock using Simple
Network Time Protocol (SNTP). Use the “sntp” command to change SNTP set-
tings.

❖ View settings

msh> sntp

❖ NTP server address configuration
You can specify the IP address of the NTP server.

msh> sntp server “IP_address”
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❖ Interval configuration

msh> sntp interval “polling_time”

• You can specify the interval at which the printer synchronizes with the op-
erator-specified NTP server. The default is 60 minutes.

• The interval can be entered from 0, or between 16 and 10,080 minutes.

• If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the
NTP server.

❖ Time-zone configuration

msh> sntp timezone “+/-hour_time”

• You can specify the time difference between the printer clock and NTP
server clock. The values are between –12:00 and +13:00.

Note

❒ You can only select either the address or host name for the ntp server.

spoolsw

Use the “spoolsw” command to view and configure Job Spool settings.

You can only specify diprint, trap, lpr, ipp, ftp, sftp, and smb(TCP/IP) protocol.

• The “spoolsw” command for configuring Job Spool settings is available only
when the optional hard disk is installed.

❖ View settings
The Job Spool setting appears.

msh> spoolsw

❖ Job Spool setting

msh> spoolsw spool {on|off}
Specify “on” to enable Job Spool, or “off” to disable it.

❖ Resetting Job spool setting

msh> spoolsw clear job {on|off}

• When the printer power is cut during job spooling, this determines wheth-
er to reprint the spooled job.

❖ Protocol configuration

msh> spoolsw diprint {on|off}
msh> spoolsw lpr {on|off}
msh> spoolsw ipp {on|off}
msh> spoolsw smb {on|off}
msh> spoolsw ftp {on|off}
msh> spoolsw sftp {on|off}

• You can specify the settings for diprint, lpr, ipp, ftp, sftp, and smb.
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ssdp

Use the “ssdp” command to view and configure SSDP settings.

❖ View settings

msh> ssdp

❖ Setting effective time

msh> ssdp profile {1801–86400}
The default is 10800 seconds.

❖ Advertise packet TTL settings

msh> ssdp ttl {1–255}
The default is 4.

ssh

Use the “ssh” command to view and configure SSH settings.

❖ View settings

msh> ssh

❖ Data compression communication settings

msh> ssh compression {on|off}
The default is “on”.

❖ SSH/SFTP communication port setting

msh> ssh port {22, 1024–65535}
The default is 22.

❖ SSH/SFTP communication timeout setting

msh> ssh timeout {0–65535}
The default is 300.

❖ SSH/SFTP communication login timeout setting

msh> ssh logintimeout {0–65535}
The default is 300.

❖ Setting an open key for SSH/SFTP

msh> ssh genkey {512|768|1024} “character string”
Create an open key for SSH/SFTP communication.
Usable characters are ASCII 0x20-0x7e (32 bytes) other than “0”.
The default key length is 1024, and the character string is blank.
If you do not specify this parameter, an open key with the default value will
be created.
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❖ Deleting open key for ssh/sftp communication

msh> ssh delkey 

Note

❒ If you do not specify a character string, current setting is displayed.

status

Use the “status” command to display the printer status.

❖ view messages

msh> status

Reference

p.91 “Current Printer Status” 

syslog

Use the “syslog” command to display the information stored in the printer's sys-
tem log.

❖ View message

msh> syslog

Reference

p.106 “System Log Information”

upnp

Use the “upnp” command to display and configure the universal plug and play.

❖ Public URL display

msh> upnp url

❖ Public URL configuration

msh> upnp url “string”

• Enter the URL string in the character string.

❖ Deleting Public URL

msh> upnp clear url
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web

Use the “web” command to display and configure parameters on Web Image
Monitor.

❖ View Settings

msh> web

❖ URL Configuration
You can set URLs linked by clicking [URL] on Web Image Monitor.

msh> web “ID” url http://”The URL or IP address you want
to register”/
Specify “1” or “2” for ID as the number corresponding to the URL. Up to two
URLs can be registered and specified.

❖ Resetting URLs registered as link destinations

msh> web “ID” clear url
Specify “1” or “2” for x as the corresponding number to the URL.

❖ Link name configuration
You can enter the name for URL that appears on Web Image Monitor.

msh> web “ID” name “Name you want to display”
Specify “1” or “2” for ID the corresponding number to the link name.

❖ Resetting URL names registered as link destinations

msh> web “ID” clear name
Specify “1” or “2” for ID as the number corresponding to the link name.

❖ Help URL Configuration
You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.

msh> web help http://”Help URL or IP address”/help/

❖ Resetting Help URL

msh> web clear help
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wiconfig

Use the “wiconfig” command to make settings for IEEE 802.11b.

❖ View settings

msh> wiconfig

❖ View IEEE 802.11b settings

msh> wiconfig cardinfo

• If IEEE 802.11b is not working correctly, its information is not displayed.

❖ Configuration

msh> wiconfig “parameter”

Parameter Value configured

mode [ap|adhoc|802.11adhoc] You can set the infrastructure mode(ap) , the 
802.11 Ad hoc mode (802.11adhoc), or the ad 
hoc mode (adhoc).

The default is ad hoc mode.

ssid “ID value” You can specify an SSID in infrastructure 
mode.

The characters you can enter in the SSID 
string are ASCII 0x20-0x7e (32 bytes). If you 
do not specify a character string, the machine 
will connect to the nearest access point. The 
default SSID is blank.

channel frequency “channel no” In 802.11 ad hoc mode, you can select a chan-
nel between 1 and 14, or 36, 40, 44, or 48.

Be sure to set the same channel for all ports 
that will transmit and receive data.

In 802.11 ad hoc mode, you can select a chan-
nel between 1 and 14, or 36, 40, 44, or 48.

Be sure to set the same channel for all ports 
that will transmit and receive data.

The default is “11”. 
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key [ “key value” ] val [1|2|3|4] You can specify the WEP key when entering 
in hexadecimal.

With a 64-bit WEP, you can use 10 digit hex-
adecimals. With a 128-bit WEP, you can use 
26 digit hexadecimals.

Up to four WEP keys can be registered. Spec-
ify the number to be registered with “val”.

When a WEP is specified by key, the WEP 
specified by key phrase is overwritten.

To use this function, set the same key 
number and WEP key for all ports that trans-
mit data to each other. Put “0x”on the front 
of WEP key.

You can omit the numbers with “val”. The 
key number is set to 1 when making these 
omissions.The default is blank.

keyphrase [ “phrase” ] val [1|2|3|4] You can specify the WEP key when entering 
in ASCII.

With a 64-bit WEP, you can use10 digit hex-
adecimals. With a 128-bit WEP, you can use 
26 digit hexadecimals.

Up to four WEP keys can be registered. Spec-
ify the number to be registered with “val”.

When a WEP is specified by key phrase, the 
WEP specified by key is overwritten.

To use this function, set the same key 
number and WEP key for all ports that trans-
mit data to each other.

You can omit the numbers with “val”. The 
key number is set to1 when making these 
omissions. The default is blank.

encval [1|2|3|4] You can specify which of the fourWEP keys 
is used for packet encoding. “1” is set if a 
number is not specified.

wepauth [open|shared] You can set an authorization mode when us-
ing WEP. The specified value and authorized 
mode are as follows:

open: open system authorized (default)

shared: shared key authorized rate

Parameter Value configured
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rate [auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting 
speed.

The speed you specify here is the speed at 
which data is sent. You can receive data at 
any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m:2 Mbps fixed

1m: 1 Mbps fixed

security {none|wep|wpa} You can specify the security mode.

none: No encryption (defaults)

wep: WEP encryption

wpa: WPA encryption

wpaenc {tkip|ccmp} You can specify WPA encryption key when 
using WPA encryption.

tkip: TKIP

ccmp: CCMP (AES) (default)

wpaauth {wpapsk|wpa} You can specify the WPA authentication 
mode when using WPA encryption.

wpapsk: WPA-PSK authentication(default)

wpa: WPA authentication

psk “character string” You can specify the Pre-Shared key.

Usable characters: ASCII 0x20-0x7e (8 to 63 
bytes).

The default is blank.

eap {tls|ttls|leap|peap} {chap|msc-
hap|mschapv2|pap|md5|tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls 
are settings for the phase 2 method, and 
must be set when using EAP-TTLS or PEAP.

Do not make these settings when using other 
EAP authentication types. 

If you select EAP-TTLS, you can select chap, 
mschap, mschapv2, pap, or md5.

If you select PEAP, you can select mschapv2 
or tls.

username “character string” You can specify the login user name for the 
Radius server.

Usable characters: ASCII 0x20-0x7e (31 
bytes) other than “@”. The default is blank.

Parameter Value configured
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wins

Use the “wins” command to configure WINS server settings.

❖ Viewing settings

msh> wins

• If the IPv4 address obtained from DHCP differs from the WINS IPv4 ad-
dress, the DHCP address is the valid address.

❖ Configuration

msh> wins “interface_name” {on|off}

• {on} means “active” and {off} means “inactive”.

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

username2 “character string” You can specify the phase 2 username for 
EAP-TTLS/PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31 
bytes) other than “@”. The default is blank.

domain “character string” You can specify the login domain name for 
the Radius server.

Usable characters: ASCII0x20-0x7e (31 bytes) 
other than “@” and “\”. The default is blank.

password “character string” You can specify the login password for the 
Radius server.

Usable characters: ASCII 0x20-0x7e (128 
bytes). The default is blank.

srvcert {on|off} You can set the server certificate. The default 
is “off”.

imca {on|off} You can enable or disable the certificate 
when the intermediate certificate authority is 
present. The default is “off”.

srvid “character string” You can set the server ID and subdomain of 
the certificate server.

Usable characters: ASCII 0x20-0x7e (128 
bytes). The default is blank. 

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

Parameter Value configured
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❖ Address configuration
Use the following command to configure a WINS server IP address:

msh> wins “interface_name” {primary|secondary} “IP address”

• Use the “primary” command to configure a primary WINS server IP ad-
dress.

• Use the “secondary” command to configure a secondary WINS server IP
address.

• Do not use “255.255.255.255” as the IP address.

❖ NBT (NetBIOS over TCP/IP) Scope ID Selection
You can specify the NBT scope ID.

msh> wins “interface_name” scope “scope ID”

• The scope ID can be entered using up to 31 alphanumeric characters.

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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SNMP

Using the SNMP manager, you can get information about the machine.

The SNMP agent operating on UDP and IPX is incorporated into the built-in Eth-
ernet board and optional IEEE 802.11b interface unit of this printer. This ma-
chine also supports SNMPv3, which increases user authentication, data
encryption, and access control security.

To encrypt communication by SNMPv3, you must specify the machine's en-
crypted password.

Important

❒ If you changed the machine's community name, change the configuration of
the connected computer accordingly, using SNMP Setup Tool. For details, see
SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB infor-
mation using these community names.

❖ Start SNMP Setup Tool

• Windows 2000:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [Programs] menu.
Click [SNMP Setup Tool].

• Windows XP/Vista:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.
Click [SNMP Setup Tool].

❖ Supported MIBs(SNMPv1/v2)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

❖ Supported MIBs(SNMPv3)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

• SNMP-FRAMEWORK-MIB

• SNMP-TARGET-MIB

• SNMP-NOTIFICATION-MIB

• SNMP-USER-BASED-SM-MIB

• SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the 
Network

This section explains details of each item displayed in the printer status and in-
formation.

Current Printer Status

This section explains how you can check the machine’s status and the items dis-
played. Depending on the options installed on the machine, some items might
not be displayed.

• UNIX: Use the “lpq” command and “rsh”, “rcp”, “ftp”, and “sftp” parame-
ters. 

• mshell: Use the “status” command. 

Messages Description

1-Sheet Bypass Error: No Select The one sheet bypass tray is open but printing from 
another tray was selected.

1-Sheet Bypass Error: Not Open The one sheet bypass tray is closed but printing from 
the one sheet bypass tray was selected. 

1-Sheet Output Error: No Select The one sheet bypass tray is open but printing from 
another tray was selected.

1-Sheet Output Error: Not Open The one sheet bypass tray is closed but printing from 
the one sheet bypass tray was selected. 

Access Restricted The job was canceled because user have no authority. 

Adding Ink... Ink is being supplied.

Adjusting... The machine is initializing or calibrating. 

Alert at Printer: Yellow LED An error has occurred.

Call Service Center There is a malfunction in the machine.

Canceled The job is reset. 

Canceling Job... The job is being reset. 

Card/Counter not inserted The machine is waiting for prepaid card or key.

Coin or amount not inserted The machine is waiting for coin to be inserted.

Coin/Key Counter not inserted The machine is waiting for coin or key counter.

Configuring... Setting is being changed. 

Cover Open: ADF The document feeder is open. 

Cover Open: Duplex Unit Left The cover of the left duplex unitis open.

Cover Open: Duplex Unit Right The cover of the right duplex unitis open.

Cover Open: Duplex Unit The cover of the duplex unit is open. 

Cover Open: Front Cover The front cover is open. 
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Cover Open: Lower Left Cover The lower left cover is open.

Cover Open:Lower Right Cover The lower right cover is open. 

Cover Open: Mid-Covers Covers for anti jamming are open.

Cover Open: Right Cover The right cover is open. 

Cover Open: Upper Left Cover The upper left cover is open

Cover Open: Upper Right Cover The upper right cover is open. 

Data Size Error The data size error occurred. 

Empty: Black Print Cartridge The black print cartridge is almost empty. 

Empty: Cyan Ink The cyan print cartridge is almost empty. 

Empty: Magenta Ink The magenta print cartridge is almost empty. 

Empty: Yellow Ink The yellow print cartridge is almost empty. 

Energy Saver Mode The machine is in Energy Saver Mode.

Envelope Setting Error: None  Printing paper type other than envelope is instructed 
when B2 lever is down.

Envelope Setting Error: Others Printing envelope is instructed when B2 lever is down. 

Error An error has occurred. 

Error at Printer: Red LED An error has occurred.

Error in Printer An error has occurred.

Error: Address Book An error has occurred in the data of the address book. 

Error: Command Transmission An error has occurred in the machine. 

Error: DIMM Value A memory error occurred. 

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: Optional Font An error has occurred in the font file of the machine. 

Error: Optional RAM An error has occurred in the optional memory unit.

Error: Parallel I/F Board An error has occurred in the parallel interface.

Error: PDL An error has occurred in the page description language. 

Error: Rem. Certificate Renewal An error has occurred in the remote server renewal. 

Error: USB Board An error has occurred in theUSB interface board. 

Error: USB Interface An error has occurred in the USB interface. 

Error: Wireless Card Wireless card is not inserted during start up, or the 
IEEE 802.11b interface unit or the wireless card is tak-
en out after start up.

Error: Wireless Board An error has occurred in the IEEE802.11b interface unit.

Full: 1-Sheet Output The one sheet output tray is full.

Full: Collector Bottle The ink collection bottle is full.

Messages Description
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Full: Front Collector Bottle The front ink collection bottle is full.

Full: Internal Tray 1 Internal tray 1 is full. 

Hex Dump Mode It is a hex dump mode. 

Immed. Trans. not connected It did not connect directly with the other party of the 
transmission. 

Immediate Transmission Failed An error has occurred while transmitting directly. 

In Use: Copier The copier is being used. 

In Use: Fax The fax is being used. 

In Use: Input Tray Other functions is using the input tray. 

Independent-supplier Ink Print cartridge that is not recommended is set. 

Key Card not inserted The machine is waiting for key card to be inserted.

Key Card/Counter not inserted The machine is waiting for key card or key counter to 
be inserted.

Key Counter not inserted The machine is waiting for key counter to be left in it.

Low: Black Print Cartridge The black print cartridge is not set correctly, or toner 
is almost running out.

Low: Cyan Print Cartridge The cyan print cartridge is not set correctly, or toner is 
almost running out.

Low: Magenta Print Cartridge The magenta print cartridge is not set correctly, or ton-
er is almost running out.

Low: Yellow Print Cartridge The yellow print cartridge is not set correctly, or toner 
is almost running out.

Malfunction: Duplex Unit There is a problem with the duplex unit. 

Malfunction: Ext. Charge Unit There is a problem with the external charge unit.

Malfunction:Lower Paper Tray(s) There is a problem with the bank motor.

Malfunction: Tray 2 There is a problem with tray 2. 

Malfunction: Tray 3 There is a problem with tray 3. 

Memory Low: Copy Memory shortage has occurred while the copy was 
operating. 

Memory Low: Data Storage Memory shortage has occurred while the document 
was being accumulated. 

Memory Low: Fax Scanning Memory shortage has occurred while transmitting the fax. 

Memory Low: Scanning Memory shortage has occurred while the scanner was 
working. 

Miscellaneous Error An unspecified error has occurred. 

Mismatch: Paper Size The indicated paper tray does not contain paper of se-
lected size.

Mismatch: Paper Size and Type The indicated paper tray does not contain paper of se-
lected size and type.

Messages Description
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Mismatch: Paper Type Indicated paper tray does not contain paper of select-
ed type.

Nearly Full: Collector Bottle The ink collection bottle is nearly full.

Nearly Full:Front CollectBottle The front ink collection bottle is nearly full.

No Paper: 1-Sheet Bypass There is no paper in 1-sheet bypasstray.

No Paper: Selected Tray There is no paper in specified tray. 

No Paper: Tray 1 There is no paper in tray 1. 

No Paper: Tray 2 There is no paper in tray 2. 

No Paper: Tray 3 There is no paper in tray 3. 

Not Detected: B2 Lever B2 lever is not correctly set. 

Not Detected: Black Cartridge The black print cartridge is not correctly set. 

Not Detected: Cyan Cartridge The cyan print cartridge is not correctly set. 

Not Detected: Duplex Feed Unit The duplex feed unit is not correctly set. 

Not Detected: Duplex Unit The duplex unit is not correctly set. 

Not Detected: Input Tray The paper feed tray is not correctly set. 

Not Detected: Magenta Cartridge The magenta print cartridge is not correctly set. 

Not Detected: Tray 1 Tray 1 is not correctly set. 

Not Detected: Tray 2 Tray 2 is not correctly set. 

Not Detected: Tray 3 Tray 3 is not correctly set. 

Not Detected: Yellow Cartridge The yellow print cartridge is not correctly set. 

Not Reached, Data Deleted Unreached job is deleted. 

Offline Printer is offline. 

Original on Exposure Glass The original remains on the exposure glass. 

Operating Thermo-range Error The machine is operating outside the permissible tem-
perature range.

Panel Off Mode The machine is in Panel-Off mode.

Panel Off Mode>>Printing ava. The machine is in Control Panel-Off mode.

Paper in Duplex Unit The paper remains in the duplex unit. 

Paper Misfeed: ADF The paper has jammed in Document Feeder. 

Paper Misfeed: Duplex Unit The paper has jammed in the duplex unit. 

Paper Misfeed: Input Tray The paper has jammed in the input tray. 

Paper Misfeed: Internal Path The paper has jammed inside the machine. 

Prepaid Card not inserted The machine is waiting for prepaid card to be inserted.

Print Complete The print was completed. 

Printing... Printing is in progress.

Processing Data is being processed. 

Messages Description
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Note

❒ For details about UNIX commands, see UNIX Supplement.

❒ Check the error contents that may be printed in the configuration page. For
details about printing a configuration page, see Printer Reference.

Proxy Address/Port Incorrect The proxy address and port setting is incorrect.

Proxy User/Password Incorrect The proxy user name and password setting is incorrect.

RC Gate Connection Error Failed connection with RC Gate. 

Ready The machine is ready to print.

Renewing Remote Certificate The remote certificate is being renewed.

Replace Collector Bottle It is time to replace the ink collection bottle.

Replace Feed Belt It is time to replace the feed belt.

Retarding... Printing has stopped momentarily to allow printed 
sheets to dry.

SD Card Authentication failed SD card authentication failed.

Setting Remotely The RDS setting is being processed. 

Skipped due to Error Skipped the error. 

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed The supply order call has failed. 

Transmission Aborted The transmission was interrupted. 

Transmission Complete The transmission completion was completed. 

Transmission Failed The transmission has failed.

Tray Error: Chaptering The paper feed tray specification error has occurred 
because chaptering as well as the normal paper use 
the same tray for printing.

Tray Error: Duplex Printing Selected paper tray cannot be used for duplex printing.

Unit Left Open: ADF Document feeder is opened.

Waiting for Job Suspension The machine is waiting for Job Suspension.

Messages Description
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Printer configuration

You can check the printer configuration using telnet.

This section explains the checking procedure for input/output tray and printer
language.

• UNIX: Use the “info” command and “rsh”, “rcp”, “ftp”, and “sftp” parame-
ters. 

• mshell: Use the “info” command. 

❖ Input Tray

❖ Output Tray

❖ Printer Language

Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Item Description

No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

Status Current status of the paper tray

• Normal:Normal

• NoInputTray: No tray

• PaperEnd:No paper

Item Description

No. ID number of the output tray

Name Name of the output tray

Status Current status of the output tray

• Normal:Normal

• PaperExist:Paper exist

• OverFlow:Paper is full

• Error:Other errors

Item Description

No. ID number of the printer language used by the 
printer

Name Name of the printer language used in the 
printer

Version Version of the printer language
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Understanding the Displayed Information 

This section explains how to read status information returned by the network in-
terface board.

Print Job Information

Use the following command to display print job information:

• UNIX: Use the “info” command and “rsh”, “rcp”, “ftp”, and “sftp” parame-
ters. 

• mshell: Use the “info” command. 

Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Item Description

Rank Print job status.

• Active
Printing or preparing for printing.

• 1st, 2nd, 3rd, 4th...
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.
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Print Log Information

This is a record of the most recent jobs printed.

Use the following command to display print log information:

• UNIX: Use the “prnlog” command and “rsh”, “rcp”, “ftp”, and “sftp” param-
eters. 

• telnet : Use the “prnlog” comman

Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed

Result Print Request Result

Communication Result

• OK
Print was completed normally. However, the print result may 
not be as required due to printer problems.

• NG
Printing was not completed normally.

• Canceled
An “rcp”, “rsh”, or “lpr” command print request was can-
celed, possibly due to the printing application. Not applicable 
to the “ftp” or “rprinter” command. 

Time Time the print requested was received.

Time of print request reception

User ID Printer driver-configured User ID.

Appears when the print request ID is specified.

JobName Name of the document for printing

Appears when the print request ID is specified.
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Configuring the Network Interface Board

Use the following command to display network interface board settings:

• telnet : Use the “show” command.

Item Description

Common

Mode

Protocol Up/Down Protocol Settings

AppleTalk

IPv4

IPv6

NetWare

SMB

PictBridge

Device Up/Down Device Settings

Parallel

USB

Bluetooth

Ethernet interface

Syslog priority

NVRAM version

Device name

Comment

Location

Contact

Soft switch

AppleTalk AppleTalk settings

Mode

Net

Object

Type

Zone
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TCP/IP TCP/IP settings

Mode(IPv4)

Mode(IPv6)

ftp

lpr

rsh

telnet

diprint

web

http

ftpc

snmp

ipp

autonet

bonjour

ssl

nrs

rfu

nbt

ssdp

ssh

sftp

IPv4

DHCP

Address

Netmask

Broadcast

Gateway

IPv6

Stateless

Manual

Gateway

EncapType

Host name

DNS Domain

Item Description



Understanding the Displayed Information

101

2

Access Control

IPv4

Access Entry[X] X can be set between 1 and 5.

IPv6

Access Entry[X] X can be set between 1 and 5.

Time server

Time Zone

Time server polling time

SYSLOG server

Home page URL1 

Home page linkname1 

Home page URL2 

Home page linkname2 

Help page URL

NetWare NetWare settings

EncapType

RPRINTER number

Print server name

File server name

Context name

Switch

Mode

NDS/Bindery

Packet negotiation 

Login Mode

Print job timeout 

Protocol

SAP interval time

NDS Tree Name

Transfer Protocol

Item Description
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SMB SMB settings

Switch

Mode

Direct print

Notification

Workgroup name

Computer name

Comment

Share name[1]

Protocol

IEEE 802.11b IEEE 802.11b settings

Host Name

Communication mode

SSID

Channel range

Channel

TX Rate

Security

WEP Authentication

WEP Encryption key number

WEP Encryptionkeys[X] X can be set between 1 and 4.

WPA Encryption

WPA Authentication

Pre-Shared Key

User name

Domain name

EAP Type

Password

Phase 2 username

Phase 2 Method TTLS

Phase 2 Method PEAP

Server cert

Intermediate CA

Server ID

Item Description
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DNS DNS settings

IPv4

Server[X] X can be set between 1 and 3.

Selected IPv4 DNS Server

IPv6

Server[X] X can be set between 1 and 3.

Domain Name

ether

wlan

DDNS

ether

wlan

WINS WINS settings

ether

Primary WINS

Secondary WINS

wlan

Primary WINS

Secondary WINS

Bluetooth Bluetooth settings

Bluetooth mode Bluetooth connection mode

SSDP SSDP settings

UUID

Profile

TTL

UPnP UPnP settings

URL

Item Description
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Bonjour Bonjour (Redezvous) settings

Computer Name (cname)

Local Hostname(ether)

Local Hostname(wlan)

Location

Priority (diprint)

Priority (lpr)

Priority (ipp)

IP TTL

LinkLocal Route for Multi I/F

SNMP SNMP settings

SNMPv1v2

SNMPv3

protocol

v1Trap

v2Trap

v3Trap

SNMPv1v2 Remote Setting

SNMPv3 Privacy

ssh ssh settings

Compression 

Port

TimeOut

LoginTimeOut

AuthFree Authfree settings

IPv4

AuthFreeEntry[X] X can be set between 1 and 5.

IPv6 

AuthFreeEntry[X] X can be set between 1 and 5

Parallel

USB

Item Description
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LPR

lprm check host 

Certificate

Verification

Shell mode Remote maintenance tool mode

Item Description
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Message List

This is a list of messages that appear in the machine's system log. The system log
can be viewed using the “syslog” command.

System Log Information

Use the following command to display the system log information:

• UNIX: Use the “syslog” command and “rsh”, “rcp”, “ftp”, and “sftp” param-
eters. 

• telnet : Use the “syslog” command. 

Message Problem and solutions

Access to NetWare server <file server name> 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect.

(In the print server mode) Login to the file 
server failed. Make sure that the print server is 
registered on the file server. If a password is 
specified for the print server, deleteit.

account is unavailable:

Same account name be used.

User account is disabled. This could be be-
cause it use the same account name as the ad-
ministrator account.

account is unavailable:

The authentication password is not set up.

User account is disabled. This could be be-
cause the authentication password is not set, 
and only the encryption account is set.

account is unavailable:

encryption is impossible.

Encryption is not possible and account is disa-
bled. This could be because:

• Encryption password has not been speci-
fied.

add_sess_IPv4: bad trap <IPv4 address>com-
munity <community name>

The IPv4 address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify 
the host IPv4 address for the TRAP destina-
tion.

add_sess_IPv6: bad trap <IPv6 address>com-
munity <community name>

The IPv6 address [::] is unavailable when the 
community access type is TRAP. Specify the 
host IPv6 address for the TRAP destination.

add_sess_IPv4: community<community name> 
already defined.

The same community name already exists. 
Use another community name.

add_sess_IPv6: community <community name> 
already defined.

The same community name already exists. 
Use another community name.

add_sess_IPX: bad trap<IPX address>commu-
nity <community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_ipx: community <communityname> 
already defined.

The same community name already exists. 
Use another community name.

Attach FileServer= <file servername> Connection to the file server as the nearest 
server has been established.
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Attach to print queue <print queue name> (In the print server mode) Attached to the 
print queue.

authenticated WPA authentication was successful.

authenticating The computer is performing WPA authentica-
tion through the access point.

authentication mode mismatch The authentication mode of the access point is 
different with the authentication mode of the 
supplicant.

Use the same authentication mode between 
the access point and the supplicant. 

btd is disabled. Communication via Bluetooth is unavailable 
because btd is disabled in the security mode.

 Enable the btd in the security mode.

centrod is disabled. Communication via parallel connectionis una-
vailable because centrod is disabled in the se-
curity mode.

Enable centrod in the security mode.

Cannot create service connection (In the remote printer mode) Connection to the 
file server has not been established. The 
number of file server users may have exceeded 
the maximum capacity of the file server.

Cannot find rprinter (<print server name>/
<printer number>)

The printer with the number displayed on the 
print server does not exist. Make sure that the 
printer number is registered on the print server.

Change IP address from DHCP Server. The IP address changes when DHCP lease is re-
newed. To always assign the same IP address, 
set a static IP address to the DHCP server.

cipher suite mismatch The cipher suite (TKIP/AES/WEP) of the 
computer and that of the access point do not 
match.

Client EAP method rejected The RADIUS server denied the EAP method of 
the client.

Client password rejected The client's password was rejected. Check the 
client password.

Client TLS certificate rejected The client's TLS certificate was rejected. Check 
the certificate.

Connected DHCP Server(<DHCP serveraddress>). The IP address was successfully received from 
the DHCP server.

connecting The supplicant is waiting for wireless connec-
tion to the access point.

Could not attach to FileServer<error number> (In the remote printer mode) Connection to the 
file server has not been established. The file 
server has refused the connection. Check the 
file server configuration.

Message Problem and solutions
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Could not attach to PServer<print server> (In the remote printermode) Connection to the 
print server has not been established. The 
print server has refused the connection. Check 
the print server configuration.

Current Interface Speed:xxxMbps Speed of the network (10Mbps, 100 Mbps, or 
1Gbps).

Current IP address <currentIP address> Current IPv4 address.

Current IPX address<IPX address> Current IPX address

DHCP lease time expired. DHCP lease time has expired.The printer tries 
to discover the DHCP server again. The IP ad-
dress until now becomes invalid.

DHCP server not found. The DHCP server was not found. Make sure 
that the DHCP is on the network.

dhcpcd start. The DHCPCD service (dhcp client service) has 
started.

dpsd is disabled. Communication via PictBridge is unavailable 
because PictBridge is disabled in the security 
mode. Enable PictBridge in the security mode.

Duplicate IP=<IP address>(from<MAC address>). The same IP address (IPv,or IPv6 address) was 
used. Each IP address (IPv, or IPv6 address) 
must be unique. Check the address of the de-
vice indicated in [MAC address].

Established SPX Connection with PServ-
er,(RPSocket=<socketnumber>, con-
nID=<connection ID>)

(In the remote printer mode) Connection to the 
print server has been established.

exiting The lpd service has ended and the system is 
exiting the process.

Exit pserver (In the print server mode) The print server 
function is disabled because the necessary 
print server settings have not been made.

Frametype =<frame typename> The frame type name is configured to be used 
on NetWare.

httpd start. The httpd service has started.

IEEE 802.11b <communication mode> mode Displays IEEE 802.11b communication mode.

IEEE 802.11b current channel Displays IEEE 802.11b channel number. 

IEEE 802.11b interface up The IEEE 802.11b link has been established.

IEEE 802.11b interface down The IEEE 802.11b link has been cut.

IEEE 802.11b card removed The IEEE 802.11b link has been cut.

inetd start. The inetd service has started.

Interface (interface name): Duplicate IP Ad-
dress (IP address).

The same IP (IPv4 or IPv6) address was used. 
Each IP address must be unique. Check the ad-
dress of the device indicated in [IP address].

Message Problem and solutions
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< Interface > started with IP: < IP address > IP address (IPv4, or IPv4 address) has been set 
for the interface and is operating..

< Interface >: Subnet overlap The same IP address (IPv, orIPv6 address) and 
the subnet mask is used with other device.

IPP cancel-job: permission denied. The printer could not authenticate the name of 
the user attempting to cancel a job.

IPP job canceled. jobid=%d. The spooled job was canceled due to error or 
user request.

LEAP challenge to access point failed LEAP authentication has failed.

LeaseTime=<lease time>(sec), Renew-
Time=<renewtime>(sec).

The resource lease time received from the 
DHCP server is displayed in [lease time] in 
seconds. The renewal time is displayed in [re-
new time] in seconds.

Login to fileserver <file server name> 
(<IPX|IPv4|IPv6>,<NDS|BIND-
ERY>)|(<IPX|IPv4|IPv6>,<NDS|BIND-
ERY>)|(<IPX|IPv4|IPv6>,<NDS|BINDERY
>)|(<IPX|IPv4|IPv6>,<NDS|BINDERY>)

(In the print server mode) Login to the file 
server is in the NDS or BINDERY mode.

Memory allocate error. Data cannot be obtained. 

Disconnect the USB cable, and then connect it.

MIC failure TKIP counter measures started An attack was detected during TKIP operation 
and the computer has taken countermeasures.

MIC failure TKIP counter measures stopped Following attack during TKIP operation, the 
computer has ended attack countermeasures 
after 60 seconds.

Name registration success. WINS Serv-
er=<WINS server address> NetBIOS 
Name=<NetBIOS name> 

Name registration of <NetBIOS Name> to 
<WINS server address> was successful.

Name registration success in Broadcast 
name=<NetBIOS Name> 

Name registration by Broadcast name of <Net-
BIOS Name> was successful.

Name registration failed. name=<NetBIOS name> Name registration of <NetBIOSName> failed. 
Change to different NetBIOS name. 

nbtd start. The nbtd service has started.

no RADIUS/authentication server A RADIUS server could not be found.

no smart card detected on device No smart card was detected on the computer 
during GTC authentication.

no WPA information element in probe re-
sponse, rescanning

There is no WPA information on the response 
from the SSID probe of the access point you 
want to use.

The supplicant is rescanning.

nprinter start (NetWare) (In the remote printer mode) The NetWare 
service has started.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Message Problem and solutions
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Open log file <file name> (In the print server mode)The specified log file 
has been opened.

Print queue <print queue name> cannot be 
serviced by printer 0, <print server name>

(In the print server mode) The print queue 
cannot be established. Make sure that print 
queue exists on the specified file server.

Print server <print servername>has no printer. (In the print server mode) The printer is not as-
signed to the print server. Using NWadmin, 
assign the printer, and then restart it. 

print session full No more print jobs can be accepted.

Printer <printer name> has no queue (In the print server mode) The print queue is 
not assigned to the printer. Using NWadmin, 
assign the print queue to the printer, and then 
restart it.

pserver start. (NetWare) (In the print server mode) The NetWare serv-
ice has started.

Required file server (<file servername>) not 
found

The required file server is not found.

received EAP Failure EAP reception failed.

restarted. The lpd service has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started.The SAP packet 
is issued to advertise the service on the SAP ta-
ble on the NetWare server.

server certificate invalid The server certificate is invalid.

server identity invalid The server ID is disabled. Check the server au-
thentication.

server not trusted The status of the RADIUS server indicates the 
server is not trustworthy.

session IPv4 <community name> not defined. The requested community name is not defined.

session IPv6 <community name> not defined. The requested community name is not defined.

session_IPX <community name> not defined. The requested community name is not defined.

Set context to <NDS contextname> An NDS context name has been set.

shutdown signal received. network service re-
booting...

The network service is rebooting.

smbd start. (NetBIOS) The smbd service has started.

Message Problem and solutions
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SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be ob-
tained. This could be because:

• The specified DNS server could not be 
found.

• No connection to the network has been es-
tablished.

• The specified DNS server could not be 
found.

• An incorrect DNS server is specified.

• The specified SMTP server IP address 
could not be found in the DNS server.

SMTPC: failed to connect smtp server. timeout. Connection to the SMTP server failed due to 
timeout. This could be because the specified 
SMTP server name is incorrect, or no connec-
tion to the network has been established, or the 
network configuration is incorrect, so there is 
no response from the SMTP server. Check the 
SMTP server name, or the network connection 
and configuration. 

SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This 
could be because server other than the SMTP 
server has been specified, or the specified 
SMTP server port number is incorrect. Check 
the SMTP server name, port number, or the 
SMTP server port number.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to 
no response from SMTP. This could be be-
cause a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the SMTP 
server name, port number, or the SMTP server 
port number.

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This 
could be because no connection to the network 
has been established,or the network configura-
tion is incorrect, so there is no response from 
the SMTP server, or the specified SMTP server 
name is incorrect, or the specified SMTP server 
IP address could not be found in the DNS serv-
er, or a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the DNS Serv-
er's IP address and SMTP server's IP address, or 
the SMTP server name and SMTP port number, 
or the SMTP server's SMTP port number, or the 
network connection and configuration.

SMTPC: username or password wasn’t cor-
rect. [response code] (information)

Connection to the SMTP server failed, because 
the specified SMTP user name is incorrect, or 
the specified SMTP password is incorrect. 
Check the SMTP user name and password.

Message Problem and solutions
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Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Snmp over IPv4 is ready Communication over IPv4 with snmp is available.

Snmp over IPv6 is ready. Communication over IPv6 with snmp is available.

Snmp over IPX is ready. Communication over IPX with snmp is available.

snmpd start. The snmpd service has started.

started. The direct print service has started.

Started. The bonjour (rendezvous) function is enabled.

stopped The supplicant is terminating.

success but invalid key The computer received a message reporting 
successful EAP authentication, but the EAPOL 
key is invalid.

success key received The supplicant received the EAP-Success key.

Terminated. The bonjour (rendezvous) function is disabled.

The print server received error <error number> 
during attempt to log in to the network. Access 
to the network was denied. Verify that the print 
server name and password are correct.

Login to the file server failed.The print server 
is not registered or a password is specified. 
Register the print server without specifying a 
password.

too many pictures. PictBridge printing failed because too many 
image are sent during one print transacation. 
Reduce images at one print transaction.

trap account is unavailable. v3Trap cannot be sent. This could be because 
the Trap destination account is different from 
the account specified by the printer.

unauthenticated The authentication failed. The supplicant was 
denied access to the access point, or was not 
authenticated.

usbd is disable. Plug and Play function and printing is disa-
bled because usbd is disabled in the security 
mode.

Enable usbd in the security mode.

waiting for keys The supplicant is waiting for the session key.

WINS name registration: No response to serv-
er<WINS server address>

There was no response from theWINS server. 
Check the correct WINS server address is en-
tered. Alternatively,check the WINS server is 
functioning properly.

WINS wrong scopeID=<Scope ID> An invalid scope ID was used.Use a valid 
scope ID.

WPA supplicant started The WPA supplicant has started.

WPA supplicant unbound The WPA supplicant is not connected to the 
unbound access point.

Message Problem and solutions
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3. Special Operations under
Windows

Printing Files Directly from Windows

You can print files directly using Windows commands. For example, you can
print PostScript files for PostScript 3.

❖ Windows 2000/XP/Vista, Windows Server 2003
You can print files directly using lpr, rcp ftp or sftp command.

Setup

Follow the procedure below to make network environment settings.

A Enable TCP/IP with the control panel, and then set up the printer’s network
environment about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

B Install a TCP/IP in Windows to set up the network environment.

Consult the network administrator for the local setting information.

C To print under Windows 2000/XP or Windows Server 2003, install “Print
services for Unix” as the network application.

Under Windows Vista, install “LPR Port Monitor”.

Note

❒ For details about installing “Print services for Unix” and “LPR Port Moni-
tor”, see Windows Help.

Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of
IP address. The host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.

When setting the IPv4 address of a printer using DHCP

Use the printer name on the configuration page as the host name.

Note

❒ For details about printing a configuration page, see General Setting Guide.
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In other cases

Add the IP address and host name of the network printer to the hosts file on the
computer used for printing.

A Open the hosts file using memo pad files, for instance.

The hosts file is in the following folder:

• Windows 2000

WINNTSYSTEM32DRIVERSETCHOSTS

• Windows XP/Vista, Windows Server 2003

WINDOWSSYSTEM32DRIVERSETCHOSTS

B Add an IPv4 or IPv6 address and host name to the hosts file using the fol-
lowing format:

192.168.15.16  host  # NP

“192.168.15.16” is the IPv4 address, “host” is the printer's host name, and
“#NP” is replaced by comments. Insert a space or tab between “192.168.15.16”
and “host”, between “host” and “#NP” respectively, using one line for this
format.

2001:DB::100 host # NP

“2001:DB::100” is the IPv6 address, “host” is the printer's host name, and
“#NP” is replaced by comments. Insert a space or tab between “2001:DB::100”
and “host”, between “host” and “#NP” respectively, using one line for this
format.

C Save the file.

Note

❒ When using a host name under Windows Server 2003 with IPv6 protocol,
perform host name resolution using an exrernal DNS server. The host file
cannot be used.
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Printing Commands

The following explains printing operations using the “lpr”, “rcp”, and “ftp”
commands.

Enter commands using the command prompt window. The location of the com-
mand prompts varies depending on operating systems:

• Windows 2000
 [Start] - [Programs] - [Accessories] - [Command Prompt] 

• Windows XP, Windows Vista, Windows Server 2003
 [Start] - [All Programs] - [Accessories] - [Command Prompt] 

Note

❒ Match the data format of the file to be printed with the emulation mode of the
printer.

❒ If the message “print requests full” appears, no print jobs can be accepted. Try
again when sessions end. For each command, the amount of possible sessions
is indicated as follows:

• lpr: 5(When the spool printing function is available: 10)

• rcp, rsh: 5

• ftp: 3

• sftp: 3

❒ Enter the file name in a format including the path from the directory execut-
ing commands.

❒ The “option” specified in a command is an intrinsic printer option and its syn-
tax is similar to printing from UNIX. For details, see UNIX Supplement.

lpr

❖ When specifying a printer by IP address

c:> lpr -Sprinter's IP address [-Poption] [-ol] \pass
name\file name

❖ When using a host name instead of an IP address

c:> lpr -Sprinter's host name [-Poption] [-ol] \pass
name\file name
When printing a binary file, add the “-ol” option (lowercase O, and lowercase L).

When using a printer with the host name “host” to print a PostScript file named
“file 1” located in the “C:\PRINT” directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1

❖ Printing from the virtual printer

C:\>lpr —S “printer's IP address” [—Pvirtual printer name]
[—ol] \path name\file name
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rcp

First, register the printer's host name in the hosts file.

c:> rcp [-b] \pass name\file name [pass name\file name...]
printer's host name:[option]

In file names, “*” and “?” can be used as wild cards.

When printing a binary file, add the “-b” option.

When using a printer with the host name “host” to print a PostScript file named
“file 1” or “file 2” located in the “C:\PRINT” directory, the command line is as
follows:

c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS

❖ Printing from the virtual printer

c:> rcp [—b] \path name\file name [\path name\file
name...] printer's host name: [“virtual printer name”]

ftp/sftp

Use the “put” or “mput” command according to the number of files to be print-
ed.

❖ When one file is printed

ftp> put \pass name\file name [option]

❖ Printing from the virtual printer

ftp> put \path name\file name [virtual printer name]

❖ When multiple files are printed

ftp> mput \pass name\file name [\pass name\file name...]
[option]

Follow the procedure below to print using the “ftp” command.

A Formulate the printer's IP address or the host name of the hosts file printer
as an argument and use the “ftp” or “sftp” command.

% ftp printer's IP address

B Enter the user name and password, and then press the {# Enter} key.

For details about the user name and password, consult your network admin-
istrator.

User:
Password:

When user authentication is set, enter a login user name and password.
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CWhen printing a binary file, set the file mode to binary.

ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

D Specify files to be printed.

The following shows the examples of printing a PostScript file named “file 1”
in the “C:\PRINT” directory and printing file 1 and file 2.

ftp> put C:\PRINT\file1 filetype=RPS
ftp> mput C:\PRINT\file1 C:\PRINT\file2

E Quit ftp.

ftp> bye

Note

❒ “=”, “,”, “_”, and “;”cannot be used for filenames. File names will be read
as option strings.

❒ For “mput” command, option can not be defined.

❒ For “mput” command, “*” and “?” can be used as wild cards in file names.

❒ When printing a binary file in ASCII mode, print may not come out cor-
rectly.
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Printing with Bluetooth Connection

This describes how to print with Bluetooth devices.

Supported Profiles

The following profiles are supported:

• SPP (Serial Port Profile)

• HCRP (Hardcopy Cable Profile)

• (Basic Imaging Profile)

❖ Restrictions on SPP, HCRP

• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

• SPP connection does not support bidirectional communications.

• HCRP connection supports bidirectional communications.

❖ Restrictions on BIP

• For BIP connection, a module including PostScript 3 must be installed in
the machine.

• Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

• Only JPEG images can be printed using BIP.

• User codes are disabled for BIP.

• You cannot print if print functions are restricted.

• Some printers do not support BIP.

Instructions in this manual relate to printing via HRCP. To print using SPP or
BIP, see the Help supplied with the Bluetooth adapter you want to use, or the
Microsoft Web site.



Printing with Bluetooth Connection

119

3

Adding a Bluetooth Printer

The following procedures explain how to install a Bluetooth printer on a com-
puter that is running Windows XP or Windows Vista.

If your computer is running SP1 or an earlier version of Windows XP, there are
additional applications that you must install. For details about these, see the
Help supplied with your Bluetooth device.

Important

❒ To perform a printer installation, your account must have Manage Printers
permission. Log on as an Administrators or Power Users group member.

❒ To connect to a Bluetooth printer, your computer must have a Bluetooth de-
vice installed. Make sure a Bluetooth device is installed on your computer.

Windows XP

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click [Add a printer].

The [Add Printer Wizard] window opens.

C Click [Next >].

D Click [Bluetooth Printer], and then click [Next >].

The computer begins searching for available Bluetooth printers.

If a new printer is discovered, the [Found New Hardware Wizard] window ap-
pears. To ignore a discovered device and continue searching, click [Cancel].
The computer resumes searching for other available Bluetooth printers.

E Click [No, I will not connect], and then click [Next >].

F Click [Install from a list or specific location (Advanced)], and then click [[Next >].

G Insert the CD-ROM provided with this machine into your computer’s CD-
ROM drive, select the [Search removable media (floppy, CD-ROM...)] check box,
and then click [Next >].

H If the [Hardware Installation] window appears, click [Continue].

I If the installation was successful, click [Finish].

J Select [Test Print], and then click [Next >].

K Click [Finish].
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Note

❒ Actual Bluetooth printer operations will vary according to your Bluetooth
device and/or Bluetooth-installed computer. For details, see the Help sup-
plied with your Bluetooth device and/or Bluetooth-equipped computer.

❒ After printing the test page, check it, and then click [Close] to close the win-
dow.

❒ If there is a problem with the test page, click [Troubleshooting] in the test
print window.

Windows Vista

Important

❒ To perform a printer installation, your account must have Manage Printers
permission. Log on as an Administrators or Power Users group member.

A On the [Start] menu, click [Control Panel].

B In the [Hardware and Sound] area, click [Printers].

C In the top part of the window, click [Add a printer].

D In the [Add Printer] window, select [Add a network, wireless or Bluetooth printer],
and then click [Next].

The computer begins searching for available Bluetooth devices.

E From the list of discovered devices, select the printer you want to use, and
then click [Next >].

All discovered wireless printers appear in the list of discovered printers, not
only Bluetooth printers. Make sure the printer you select is a Bluetooth printer.

F Insert the CD-ROM provided with this machine into your computer’s CD-
ROM drive, and then click [Browse my computer for driver software (advanced)]
on the [Found New Hardware] display.

G In the [Found New Hardware] window, select the printer driver you want to
use, and then click [Next].

The printer driver installation starts.

H If the [Windows Security] window appears, click [Install this driver software anyway].

I Click [Close].

J If you want to change the printer name, enter the new name in the [Printer
Name Settings] window.

K If you want to print a test page, click [Printing Test Page] on the “Test Print”
page.

Otherwise, click [Finish].
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Note

❒ If you print the test page, after checking it, click [Close] to close the test
print window.

❒ If there is a problem with the test page, click [Troubleshooting Printer Prob-
lems] in the test print window.



Special Operations under Windows

122

3



123

4. Appendix

When Using Windows Terminal Service / 
MetaFrame

The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

❖ Windows NT Server 4.0 Terminal Server Edition

• MetaFrame 1.8 SP3 / FR1+SP3 / SP4

• MetaFrame XP 1.0 SP1 / SP2 / FR1

❖ Windows 2000 Server / Advanced Server

• MetaFrame 1.8 SP3 / FR1+SP3 / SP4

• MetaFrame XP 1.0 SP1 / SP2 / SP3 / FR1 / FR2 / FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

❖ Windows 2003 Server

• MetaFrame XP 1.0 FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Supported Printer Drivers

❖ When Windows Terminal Service is operating

• PCL drivers

• PostScript 3

• RPCS drivers

Note

❒ Some RPCS printer driver functions do not work if Windows Terminal Serv-
ice is installed.
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Limitations

The following limitations apply to the Windows Terminal Service environment.

These limitations are built in Windows Terminal Service or MetaFrame.

❖ Windows Terminal Service
In the Windows Terminal Service environment, some of the printer driver’s
functions is unavailable. In an environment where Windows Terminal Serv-
ice is installed, some of the printer driver’s functions is unavailable, even if
any function of Windows Terminal Service is not used. When you install
SmartDeviceMonitor for Client in an environment where the Terminal Serv-
ice is running on a Windows NT Server 4.0 Terminal Server Edition or the
Windows 2000 Server family computer, be sure to install it using the install
mode. The following are the two methods of installation using the install
mode:

A Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor
for Client.

B Enter the following command in the MS-DOS command prompt:
To quit the install mode, enter the following command in the MS-DOS com-
mand prompt.

❖ MetaFrame's [Auto-creating client printers] 
Using [Auto-creating client printers] can select a logical printer created by copy-
ing the client's local printer data to the MetaFrame server. We strongly recom-
mend testing this function in your network environment before using it for
your work.

• The settings for optional equipment will not be stored in the server after
the equipment is disconnected. The settings for optional equipment will be
restored to its defaults each time the client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a
WAN environment over dial-up lines such as ISDN, printing may not be
possible or errors may occur, depending on data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making
settings in [Client Printer bandwidth] under [Citrix Management Console] accord-
ing to the environment.

• If a print error occurs on the server and the print job or a printer created in
[Auto-creating client printers] cannot be deleted, we recommend the follow-
ing:

• MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1
Make settings in [Delete unfinished print jobs] in the registry. For details,
see the Readme file provided with MetaFrame.

• MetaFrame XP 1.0 FR2
Make settings in [Delete pending print jobs at logout] under [Printer Proper-
ties Management] of Citrix Management Console.
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❖ MetaFrame's [Printer driver replication] 
Using [Printer driver replication] can distribute printer drivers across all servers
in a server farm. We strongly recommend testing this function in your net-
work environment before using it for your work.

• If the printer drivers are not properly copied, install them directly onto
each server.
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Using DHCP

You can use the printer in a DHCP environment. You can also register the print-
er NetBIOS name on a WINS server when it is running.

Printers that register the printer NetBIOS name on a WINS server must be con-
figured for the WINS server.

Supported DHCP servers are Microsoft DHCP Server included with Windows
2000 Server, and Windows Server 2003, and the DHCP server included with
NetWare and UNIX.

If you do not use the WINS server, reserve the printer's IP address in the DHCP
server so the same IP address is assigned every time.

To use the WINS server, change the WINS server setting to “active” using the
control panel.

Using the WINS server, you can configure the host name via the remote network
printer port.

DHCP relay-agent is not supported. If you use DHCP relay-agent on a network
via ISDN, it will result in increased line charges. This is because your computer
connects to the ISDN line whenever a packet is transferred from the printer.

If there is more than one DHCP server, use the same setting for all servers. The
machine operates using data from the DHCP server that responds first.

DHCP servers can operate in an IPv6 environment, but they cannot be config-
ured to allocate IPv6 addresses or obtain host names.

Using AutoNet

If the printer IPv4 address is not automatically assigned by the DHCP server, a
temporary IP address starting with 169.254 and not used on the network can be
automatically selected by the printer.

Note

❒ The IP address assigned by the DHCP server is given priority over that select-
ed by AutoNet.

❒ You can confirm the current IPv4 address on the configuration page. For
more information about the configuration page, see General Settings Guide.

❒ When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

❒ The machine cannot communicate with devices that do not have the AutoNet
function. However, this machine can communicate with Macintosh comput-
ers running Mac OS X 10.2.3. or higher.
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Configuring the WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when the power is turned on. This enables the NetBIOS name of the printer to
be specified from SmartDeviceMonitor for Admin even in a DHCP environ-
ment.

This section explains configuring the WINS server.

Note

❒ For details about the WINS server settings, see Windows Help.

❒ If there is no reply from the WINS server, the NetBIOS name is registered by
broadcast.

❒ The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

A Start a Web browser.

B Enter “http://(machine's IP address or host name) /” in the address bar to ac-
cess the printer whose settings you want to change.

Top Page of Web Image Monitor appears.

C Click [Login].

The dialog box for entering the user name and password appears.

D Enter the user name and password, and then click [Login].

Contact your administrator for information about the settings.

E Click [Configuration] in the menu area, and then click [IPv4]on the [Network]
area.

F Check that [Enable] is selected for [WINS] in the [Ethernet+IEEE 802.11b] col-
umn, and then enter the WINS server IPv4 address in [Primary WINS Server]
and [Secondary WINS Server].

G Click [OK].

H Quit Web Image Monitor.

Using telnet

You can also use telnet to configure WINS.

Reference

p.88 “wins”
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Using the Dynamic DNS Function

Dynamic DNS is a function which dynamically updates (registers and deletes)
records (A record, AAAA record, CNAME, and PTR record) managed by the
DNS server. When a DNS server is part of the network environment to which
this printer, a DNS client, is connected, records can be dynamically updated us-
ing this function.

Updating

Updating procedure varies depending on whether the printer IP address is static
or acquired by DHCP.

Important

❒ Dynamic update using message authentication (TSIG, SIG(0)) is not support-
ed.

❖ For a static IPv4 setting
If the IP address or host name is changed, the A and PTR records are updated.
If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:

• Ethernet and IEEE 802.11
RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)
However, if CNAME (PRNXXXXXX) overlaps with the host name,
CNAME will not be registered.

❖ For DHCPv4 settings
As a substitute for the printer, the DHCP server updates the record, and one
of the following occurs:

• When the printer acquires the IP address from the DHCP server, the
DHCP server updates the A and PTR records.

• When the printer acquires the IP address from the DHCP server, the print-
er updates the A record, and the DHCP server updates the PTR record.

If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:

• Ethernet and IEEE 802.11
RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)

❖ For IPv6 settings
This machine updates the AAAA record and PTR record.
It also updates CNAME when the AAAA record is updated.
When a stateless address is newly set, it is automatically registered on the
DNS server also.
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Note

❒ When the dynamic DNS function is not used, records managed by the DNS
server must be updated manually, if the printer's IP address is changed.

❒ To update the record using the printer, the DNS server has to have one of the
following:

• No security settings made.

• If security settings are made, an IP-specified client (this printer) permits
updating.

DNS servers targeted for operation

❖ For static IP setting

• Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

• BIND 8.2.3 or higher

❖ For DHCP setup, when the printer updates the A record

• Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

• BIND 8.2.3 or higher

❖ For DHCP setup, when the DHCP server updates records

• Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

• BIND 8.2.3 or higher

• DNS servers with standard NetWare 5 (or a higher version) features

❖ For IPv6 setting

• Microsoft DNS servers with standard Windows Server 2003 features

• BIND 9.2.3 or higher
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DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record
and PTR record are as follows:

• Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3
or higher versions)/ Windows Server 2003 features

• ISC DHCP 3.0 or higher

• DHCP server with standard NetWare 5 features

Setting the dynamic DNS function

Make settings with telnet using the “dns” command.

Reference

p.63 “dns”
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Precautions

Please pay attention to the following when using the network interface board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When using NetWare (file server)

If the NetWare file server and printer are on opposite sides of a router, packets
are sent back and forth continuously, possibly incurring communications charg-
es. Because packet transmission is a feature of NetWare, you need to change the
configuration of the router. If the network you are using does not allow you to
configure the router, configure the machine instead.

❖ Configuring the router
Filter packets so they do not pass over the dial-up router.

Note

❒ The MAC address of the filtering printer is printed on the printer configu-
ration page. For more information about printing a configuration page, see
“Print I/F Settings List”, General Settings Guide.

❒ For more information about configuring the printer if the router cannot be
configured, see the following instructions.

Configuring the printer with NetWare

A Following the setup method described earlier in this manual, configure the
file server.

B Set the frame type for NetWare environment.

Note

❒ For more information about selecting a frame type, see the General Set-
tings Guide.

Configuring the printer without NetWare

AWhen not printing, the network interface board sends packets over the net-
work. Set NetWare to “inactive”.

Note

❒ For more information about selecting a protocol, see General Settings
Guide.



Appendix

132

4

When Using Network Utility

If the machine is connected to a network, observe the following points when set-
ting up the machine or changing settings:

For more details, see the operating instructions and Help for ScanRouter V2 Pro-
fessional and DeskTopBinder Lite/Professional.

❖ When a dial-up router is connected in a network environment
The settings for the delivery server to be connected must be made appropri-
ately for the machine with ScanRouter V2 Professional, Auto Document Link,
or DeskTopBinder Lite/Professional. In addition, set up connected devices
using the I/O settings of ScanRouter V2 Administration Utility.
If the network environment changes, make the necessary changes for the de-
livery server using the machine, the administration utility of client comput-
ers, Auto Document Link, and DeskTopBinder Lite/Professional. Also, set
the correct information for the connected devices using the I/O settings of
ScanRouter V2 Administration Utility.

Important

❒ If the machine is set up to connect to the delivery server via a dial-up rout-
er, the router will dial and go online whenever a connection to the delivery
server is made. Telephone charges may be incurred.

❖ When connected to a computer that uses dial-up access

• Do not install ScanRouter V2 Professional on a computer which uses dial-
up access.

• When using ScanRouter V2 Professional, DeskTopBinder Lite/Profession-
al, Auto Document Link, or a TWAIN driver on a computer with dial-up
access, a dial-up connection may be performed when connecting to the de-
livery server and other equipment, depending on the setup. If the compu-
ter is set up to connect to the Internet automatically, the confirmation
dialog box will not appear, and telephone charges may be incurred with-
out your being aware of it. To prevent unnecessary connections, the com-
puter should be set up so the confirmation dialog box always appears
before establishing a connection. Do not make unnecessary connections
when using the above listed software.
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NetWare Printing

Important

❒ IPv6 cannot be used on this function.

Form feed

You should not configure form feed on NetWare. Form feed is controlled by the
printer driver on Windows. If NetWare form feed is configured, the printer
might not work properly. If you want to change form feed settings, always con-
figure them using Windows.

• Under Windows 2000/XP and Windows Server 2003, clear the [Form feed]
check box on the [NetWare Settings] tab in the printer properties dialog box.

Banner page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it using Windows.

• Under Windows 2000/XP and Windows Server 2003, clear the [Enable banner]
check box on the [NetWare Settings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Depending on the NetWare
specification, print jobs may be accepted, but they will not be printed during this
interval.

When using the machine as a remote printer, wait about two minutes after reset-
ting before attempting to print.



Appendix

134

4

When the optional IEEE 802.11b interface unit Is Installed

When using the wireless LAN interface on the network, note the following:

❖ When moving the machine
Detach the antennas when relocating the machine locally.
After moving the machine, reattach the antennas, ensuring that: 

• The antennas are positioned clear of obstacles.

• There is 40 to 60 mm between the antennas, so that they do not touch.

• The exposure glass cover and the Auto Document Feeder (ADF) do not
knock the antennas.

❖ If the network area provides poor radio environment
Where radio wave conditions are bad, the network may not function due to
interrupted or failed connections. When checking the wireless LAN signal
and the access point, follow the procedure below to improve the situation:

• Position the access point nearer to the machine.

• Clear the space between access point and machine of obstructions.

• Move radio wave generating appliances, such as microwaves, away from
the machine and access point.

Note

❒ For information about how to check radio wave status, see the General Set-
tings Guide.

❒ For more information about access point radio wave conditions, refer to the
access point manual.
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Configuring WPA

WPA uses an authentication server to provide greatly enhanced security com-
pared to WPA-PSK.

WPA can be configured using Web Image Monitor’s administrator mode. You
can select four types of EAP authentication method: EAP-TLS, LEAP, EAPTTLS
and PEAP. Note that each EAP authentication method has different configura-
tion settings and authentication procedures.

Types and requirements of certificates are as follows:

If a certificate is required, configure all settings after installing the certificate.

❖ EAP Types Requiring a “Site Certificate”
EAP-TLS, EAP-TTLS, PEAP (Necessary except LEAP)

❖ EAP Types Requiring a “Site Certificate” and a “Device Certificate”
EAP-TLS, PEAP (Phase 2 is for TLS only)

Important

❒ To set WPA, you must enable SSL. For details, see “SSL (Secure Sockets Lay-
er) Encryption ”, Security Reference.

❒ To set WPA, you must use Web Image Monitor.

Installing a Site Certificate

A Access the authentication server and obtain the CA certificate.

Methods of obtaining certificates differ according to the operating system you
are using.

B Log on to Web Image Monitor in the administrator mode.

C Click [Configuration] in the menu area.

D [Site Certificate] in the “Security” area.

E Click [Browse] on the “Site Certificate to Import” window, and then select
the CA certificate you obtained.

F Click [Import].

G Check that the imported certificate's [Status] shows “Trustworthy”.

If [Site Certificate Check] shows “Active”, and the [Status] of the certificate
shows “Untrustworthy”, communication might not be possible.

H Click [OK].

I Click [Logout].

J Quit the Web Image Monitor.
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Installing Device Certificate

A Log on to Web Image Monitor in the administrator mode.

B Click [Configuration] in the menu area, and then click [Device Certificate] in
“Security” area..

C Click [Certificate 2] on the “Device Certificate” window, and then click [Re-
quest].

D Enter appropriate “Common Name” and “Country Code” on “Certificate
Information” page, and then click [OK].

E “Updating...” appears. Wait for about 2 minutes, and then click [OK].

F Click [Details], shown in the “Device Certificate” window as the memo pad
icon for “Requesting”.

G Select all, and then copy the entire “Text for Requested Certificate” text
that is displayed in the “Certificate Status” window.

H Access the certificate authority server, and then obtain the CA signified cer-
tificate using the text copied into “Text for Requested Certificate” win-
dows.

Obtaining the certificate differs depending on the environment you want to
use.

I Click [Certificate 2] on “Device Certificate” window, and then click [Install].

J Using a text editor, open the CA signified certificate downloaded in step 11,
and then copy over all the text.

K In the [Install Certificate] window, paste all the text copied into the CA signi-
fied certificate.

L Click [OK].

M “Updating...” appears. Wait for about one or two minutes, and then click
[OK].

N Check that the “Device Certificate” shows “Installed”.

O Click [Certificate 2] on “Certification”, and then click [OK].

P Click [Logout].

Q Quit Web Image Monitor.
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Note

❒ If you request two certificates simultaneously, the certificate authority
might not display either certificate. Click [Cancel Request] to cancel the re-
quest.

❒ You can select [Certificate 1] and [Certificate 2] in the “Device Certificate”
window. Note that if you select [Certificate 1] in the “Device Certificate”
window, you must select “Certificate 1” in the “IEEE 802.11” drop down
menu in the “Certification” window.

❒ Click [Cancel Request] to cancel the request for the server certificate.

❒ If “Not found” appears after clicking [OK] in steps G and O, wait one or two
minutes, and then click [Refresh].

Setting Items of WPA

A Log on to Web Image Monitor in the administrator mode.

B Click [Configuration] in the menu area, and then click [Wireless LAN Settings]
in the “Interface” area.

C Select [Infrastructure Mode] in “Communication Mode”.

D Enter the alphanumeric characters (a-z, A-Z, or 0-9) in [SSID] according to
the access point you want to use.

E Select [WPA] in “Security Type”.

F Select [TKIP] or [CCMP (AES)] in “WPA Encryption Method” according to the
access point you want to use.

G Select [WPA] in “WPA Authentication Method”.

H In “User Name”, enter the user name set in the RADIUS server.

I Enter the domain name in “Domain Name”.

J Select “EAP Type”. Configurations differ according to the EAP Type.

❖ EAP-TLS

• Make the following settings according to the operating system you are
using:

• Select [On] or [Off] in “Authenticate Server Certificate”.

• Select [On] or [Off] in “Trust Intermediate Certificate Authority”.

• Enter the host name of the RADIUS server on “Server ID”.

❖ LEAP

• Click [Change] in “Password”, and then enter the password set in the
RADIUS server.
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❖ EAP-TTLS

• Click [Change] in “Password”, and then enter the password set in the
RADIUS server.

• Click [Change] in “Phase 2 User Name”, and then enter the user name
set in the RADIUS server.

• Select [CHAP], [MSCHAP], [MSCHAPv2], [PAP], or [MD5] in “Phase 2 Meth-
od”.

• Certain methods might not be available, depending on the RADIUS
server you want to use.

• Make the following settings according to the operating system you are
using:

• Select [On] or [Off] in “Authenticate Server Certificate”.

• Select [On] or [Off] in “Trust Intermediate Certificate Authority”.

• Enter the host name of the RADIUS server in “Server ID”.

❖ PEAP

• Click [Change] in “Password”, and then enter the password set in the
RADIUS server.

• Click [Change] on “Phase 2 User Name”, and then enter the user name
set in the RADIUS server.

• Select [MSCHAPv2] or [TLS] in “Phase 2 Method”.

• When you select [TLS], select the client certificate you want to use in
“WPA Client Certificate”.

• Make the following settings according to the operating system you are
using:

• Select [On] or [Off] in “Authenticate Server Certificate”.

• Select [On] or [Off] in “Trust Intermediate Certificate Authority”.

• Enter the host name of the RADIUS server on “Server ID”.

K Click [OK].

L Click [Logout].

M Quit the Web Image Monitor.

Note

❒ If there is a problem with settings, you might not be able to communicate
with the printer. To identify the problem, print a network summary.

❒ If you cannot identify the problem, reset the printer interface to normal,
and then repeat the procedure from the beginning.
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Setting Up the Machine on a Network

This section describes the network settings you can change with User Tools (Sys-
tem Settings). Make settings according to functions you want to use and the in-
terface to be connected.

Important

❒ These settings should be made by the systems administrator, or after consult-
ing with the systems administrator.

Initial Settings Overview

❖ Interface Settings

❖ Network

Menu Description

Machine IPv4 Address Specifies the machine IPv4 address and sub-
net mask in the network environment.

IPv4 Gateway Address Configure the gateway address for the router 
or host computer used as a gateway.

Machine IPv6 Address Specifies the machine IPv6 address and sub-
net mask in the network environment.

IPv6 Gateway Address Configure the gateway address for the router 
or host computer used as a gateway.

IPv6 Stateless Setting Specifies the automatic configuration of the 
IPv6 Stateless Address. 

DNS Configuration Make settings for the DNS server.

DDNS Configuration Specifies the DDNS settings.

Domain Name Specifies the domain name.

WINS Configuration Specifies the WINS server settings.

Effective Protocol Select the protocol to use in the network.

NCP Delivery Protocol Select the protocol for NCP delivery.

NW Frame Type Select the frame type when you use NetWare.

SMB Computer Name Specifies the SMB computer name.

SMB Work Group Specifies the SMB work group.

Ethernet Speed Set the access speed for networks.

LAN Type Select interface, IEEE 802.11b (wireless LAN) 
or Ethernet when you have installed the op-
tional IEEE 802.11b interface unit.

Ping Command Check the network connection with ping 
command using given IP address.
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❖ IEEE 802.11b

❖ File Transfer

Permit SNMPv3 Communictn. Set the encrypted communication of SNMP v3.

Permit SSL/TLS Comm. Set the encrypted communication of SSL/TLS.

Host Name Specify the host name.

Machine Name Specify the machine name.

Menu Description

Communication Mode Specifies the communication mode of the 
wireless LAN.

SSID Setting Specifies SSID to distinguish the access point 
in infrastructure mode or 802.11 ad hoc mode.

Channel Specifies a channel when you select 802.11b 
ad hoc mode or ad hoc mode.

Security Type Specifies the encryption of the IEEE 802.11b 
(wireless LAN). 

Communication Speed Specifies the communication speed of the 
IEEE 802.11b (wireless LAN).

Restore Defaults Return the IEEE 802.11b (wireless LAN) set-
tings to their defaults.

Menu Description

Delivery Option Enables or disables sending scanned docu-
ments via the ScanRouter delivery software 
delivery server.

SMTP Server Specifies the SMTP server name.

SMTP Authentication Configures SMTP authentication (PLAIN, 
LOGIN, CRAM-MD5, DIGEST-MD5

POP before SMTP Configures POP authentication (POP before 
SMTP).

Reception Protocol Specifies Reception Protocol for receiving 
Internet faxes.

POP3/IMAP4 Settings Specify the POP3 or IMAP4 server name for 
receiving Internet faxes.

Admin. E-mail Address This appears as the sender’s address on e-
mailed scanned documents, if the sender is 
not specified .

E-mail Communication Port Specifies the POP3, IMAP4, and SMTP port 
numbers for receiving Internet faxes.

E-mail Recept. Interval Specify, in minutes, the time limit for receiv-
ing Internet faxes via POP3 or IMAP4 server.

Menu Description
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Max. Recept. E-mail Size Specifies the Max. Reception E-mail Size for 
receiving Internet faxes.

E-mail Storage in Server Specifies whether or not to store received In-
ternet fax e-mails on the POP3 or IMAP4 
server.

Default User Name/PW(Send) Specifies the user name and password re-
quired when sending scan file directly to a 
shared folder on a computer running Win-
dows, or to an FTP server.

Auto Specify Sender Name Set name of the sender when sending an e-
mail.

Fax E-mail Account Specify [E-mail Address], [User Name], and 
[Password] for receiving Internet faxes.

Scanner Resend Time Specifies the interval the machine waits be-
fore resending scan file, if they cannot be 
sent to the delivery server or mail server.

Scanner Resend Setting Sets a maximum number of times scan file is 
resent to the delivery server or mail server.

Menu Description
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Initial Settings

❖ Printer/LAN-Fax (IPv6 cannot be used on LAN-Fax.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless Setting

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

NW Frame Type

SMB Computer Name

SMB Work Group

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Machine Name
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IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless Setting

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

NW Frame Type

SMB Computer Name

SMB Work Group

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Machine Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

Interface Settings
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❖ Internet Fax (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

File Transfer Delivery Option

SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

POP3/IMAP4 Settings

Admin. E-mail Address

E-mail Communication Port

E-mail Recept. Interval

Max. Recept. E-mail Size

E-mail Storage in Server

Default User Name/PW(Send)

Fax E-mail Account
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IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

WINS Configuration

DDNS Configuration

Domain Name

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

File Transfer SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

POP3/IMAP4 Settings

Admin. E-mail Address

E-mail Communication Port

E-mail Recept. Interval

Max. Recept. E-mail Size

E-mail Storage in Server

Fax E-mail Account

Interface Settings
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❖ IP-Fax (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

WINS Configuration

DDNS Configuration

Domain Name

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed
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❖ E-mail (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

File Transfer SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

POP3/IMAP4 Settings

Admin. E-mail Address

E-mail Communication Port
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IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

File Transfer SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

Admin. E-mail Address

E-mail Communication Port

Interface Settings
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❖ Scan to Folder (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

File Transfer Default User Name/PW(Send)

Scanner Resend Time

Scanner Resend Setting
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IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

File Transfer Default User Name/PW(Send)

Scanner Resend Time

Scanner Resend Setting

Interface Settings
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❖ Network Delivery Scanner (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Delivery Option

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

File Transfer Delivery Option

Scanner Resend Time

Scanner Resend Setting
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IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

File Transfer Delivery Option

Scanner Resend Time

Scanner Resend Setting

Interface Settings
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❖ Network TWAIN Scanner (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed
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Note

❒ Depending on which optional units you have installed or the printer lan-
guage you have selected, some options are not displayed.

❒ Depending on the security settings, you might not be able to set certain op-
tions.

Reference

For details about initial settings, see “System Settings”, General Settings
Guide.

For details about copier features and system settings, see Copy Reference and
General Settings Guide.
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Specifications

Interface 100BASE-TX, 10BASE-T, IEEE 802.11b

Frame type EthernetII, IEEE 802.2, IEEE 802.3, SNAP

Printer (LAN-Fax) IPv4

LPR

RSH

RCP

DIPRINT

FTP

IPP 

IPX/SPX (NetWare)

AppleTalk

SMB

Internet Fax IPv4

SMTP

POP3

IMAP4

Network Scanner IPv4

RSH

FTP

SMTP

POP3

SMB

NCP

Management Function IPv4

RSH

RCP

FTP

SNMP

HTTP

TELNET (mshell)

NBT

DHCP

DNS

LDAP

SNMP v1/v2 MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB

SNMP v3 MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB, SNMP-
FRAMEWORK-MIB, SNMP-TARGET-MIB, SNMP-NOTIFICA-
TION-MIB, SNMP-USER-BASED-SM-MIB, SNMP-VIEW-
BASED-ACM-MIB
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To use IPP and SMB, use the SmartDeviceMonitor for Client port.

To use IPP under Windows XP, Windows Server 2003, use the Standard IPP
port. To use IPP under Windows 2000, use SmartDeviceMonitor for Client.

AppleTalk can be used when the PostScript 3 unit is installed.

Functions

The following functions are available with the machine:

• Copy

• Printer

• Scanner
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A

Access Control,   55
Adding a Bluetooth Printer,   119
appletalk,   56
authfree,   57
Auto E-mail Notification,   47
AutoNet,   126
Autonet,   57

B

Bluetooth,   60
Bonjour,   58

C

Changing the Network 
Interface Board Configuration,   33

Changing the Paper Type,   34
Configuring the Energy Saver Mode,   38
Configuring the WINS Server,   127
Configuring WPA,   135
Current Printer Status,   91

D

DHCP,   61, 126
DHCP servers targeted for operation,   130
dial-up router,   131
Displaying Web Image Monitor Help,   29
DNS,   63
DNS servers targeted for operation,   129
Domain Name,   65

F

Functions,   156

G

Getting Printer Information 
over the Network,   91

Going to the Top Page,   20

H

Host Name,   66
How to Read This Manual,   1

I

IEEE 802.11b,   85
ifconfig,   67
info,   68
information,   76, 97, 98, 99, 106
Installing,   32
IPP,   68
ipv6,   69

J

Job Spool,   81

L

List of the Setting Items,   25
Locking the Menus on 

the machine's Control Panel,   33
lpr,   69

M

Mail authentication,   49
Managing User Information,   35
message,   106
MIB,   90

N

netware,   70
NetWare 5/5.1,   8, 10
NetWare 6/6.5,   8, 10
Notify by e-mail function,   45

P

passwd,   71
Password,   71
precautions,   131
Printer Status Notification by E-mail,   45
Printing Commands,   115
Printing Files Directly from Windows,   113
Printing with Bluetooth Connection,   118
prnlog,   72
Pure IP,   10

R

remote printer, setup,   15
route,   72
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S

Sending E-mail Notification,   50
set,   74
Setting a Password,   38
Setting the dynamic DNS function,   130
Setting Up as a Print Server,   7, 8, 10
Setting Up as a Remote Printer,   12, 15
Setup,   113
show,   76
slp,   76
SmartDeviceMonitor for Admin,   32
smb,   76
SNMP,   90
snmp,   77
sntp,   80
specifications,   155
spoolsw,   81
status,   83
Supported Profiles,   118
syslog,   83

T

TCP/IP address,   67
telnet,   54, 57, 88
Types of Menu Configuration and Mode,   23

U

Updating,   128
Using a Host Name 

Instead of an IP Address,   113
Using telnet,   127
Using the Dynamic DNS Function,   128
Using Web Image Monitor,   127

W

Web Image Monitor,   19, 25

WINS,   88
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